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General

1 General

The Schaeffler SmartWeb software offers you a user interface with which you can manage the Schaeffler
SmartCheck or ProLink device. For example, you can configure inputs and outputs, use a wizard to create
measurement jobs for monitoring your machine, or verify the functions of the SmartCheck or ProLink device. To be
able to use the SmartWeb software, the device must be connected to a computer.

About the vibration monitoring systems
SmartCheck and ProLink are vibration monitoring systems for permanent frequency-selective monitoring. They offer
you the following functionality:

The Schaeffler SmartCheck system can capture, record and analyse measurement values using two integrated
signals and up to three connected signals. After the analysis, the system can switch outputs and display the status
using LEDs depending on user-defined alarm limits. Inputs are available, which record additional signals, to allow the
device to be integrated into a superordinate system. These signals can be used as command variables for a
dependent signal analysis, e.g. to initiate time or event-controlled measurement jobs.

The Schaeffler ProLink system consists of a processor module and at least one vibration module. The system can
be extended to a maximum of 4 vibration modules. Up to 4 analogue and 2 digital signals can be connected per
vibration module and measured values can be logged, recorded and analysed. After the analysis, the system can
switch up to 4 digital outputs per vibration module depending on user-defined alarm limits, and report the state to
an external control system, for example. In addition, up to eight analogue or digital inputs or outputs can be
created completely flexibly per connected I/O module.

The Schaeffler vibration monitoring system can be used to cover a wide range of applications; the system can be
configured to meet your own requirements using the integrated SmartWeb web application. You can combine
multiple SmartCheck or ProLink devices in a network. All devices are administered centrally on a PC via the
SmartUtility Light software. With the full version of SmartUtility, you can also open the devices directly in the
SmartWeb software, analyse measurement data in the SmartUtility Viewer and download configurations and install
them on other devices.

With the SmartCheck and ProLink system, Schaeffler offers status monitoring that is optimised to suit your
requirements.
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1.1 About this guide

This guide describes how to use the Schaeffler SmartWeb software. Read this guide carefully before using the
software, and store it in a safe place.

Make sure that

· This guide is available to all users

· If the product is passed on to other users, that this guide is also passed on with it.

· Additions and amendments provided by the manufacturer are always attached to this guide.

System-specific instructions and illustrations
You can use the software described here with both the Schaeffler SmartCheck system and
the Schaeffler ProLink system. The usage is largely the same for both systems. The text in
this manual always highlights any differences.

Illustrations provide examples to clarify the information and instructions contained in the text.
For instances where there is hardly any difference between the systems, we have omitted
the illustration of the other system to improve readability and clarity.

Further information
This software is an integral part of the Schaeffler SmartCheck or ProLink vibration monitoring system. These systems
also include the Schaeffler SmartUtility Light software. The individual systems and the SmartUtility Light software are
described in a separate manual.

Optionally, instead of the Schaeffler SmartUtility Light software, you can purchase the Schaeffler SmartUtility
software with enhanced functionality. This is also described in a separate manual.

Definitions
· Product: the Schaeffler SmartWeb software described in this manual.

· User: person or organisation capable of putting the product into operation and using it.

Symbols used

This symbol indicates

· Helpful additional information and

· device settings or practical tips that will help you to perform activities more efficiently.

CAUTION The damage that can occur is described here

Actions to prevent the damage are explained here.

Cross-reference symbol : This symbol refers to a page in the manual that provides further information. If you are
reading the manual in PDF format on a screen, clicking the word to the left of the cross-reference symbol will take
you straight to the section in question.

6
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Starting the software

2 Starting the software

Perform a firmware update before commissioning. You can download the latest version via
the SmartUtility software or from the microsite for the following systems:

· SmartCheck: www.schaeffler.de/condition-
monitoring/smartcheckwww.schaeffler.de/en/condition-monitoring/smartcheck

· ProLink: www.schaeffler.de/condition-monitoring/prolinkwww.schaeffler.de/en/condition-
monitoring/prolink

Only start the SmartWeb software after ensuring the following:

· The system is connected to the Ethernet network or to your computer via the Ethernet cable.

· The system is supplied with power.

· The system has finished loading and starting and is in measuring mode.

Details on how to connect and start your Schaeffler SmartCheck or ProLink device can be found in the user
documentation for the relevant vibration monitoring system.

The Schaeffler SmartWeb software can be started in two different ways:

· Start with IP address in the browser
The Schaeffler SmartCheck or ProLink device is delivered with the default IP address 192.168.1.100. Enter this IP
address in the address field of your browser:

Press the Enter key to start the SmartWeb software.

· Start-up via the Schaeffler SmartUtility Light or Schaeffler SmartUtility software
With this software, you can search for and open Schaeffler SmartCheck or ProLink devices with the help of a wizard.
In doing so, the SmartWeb software opens in a separate tab of your browser for each device. For more details,
refer to the manual for the software SmartUtility Light or SmartUtility.

This option also requires the system to be connected to the Ethernet network or to your computer via the
Ethernet cable and supplied with power.

· If you cannot adapt the IP address field on your computer to the default IP address of
the Schaeffler SmartCheck or ProLink device, you will need to change the IP address of
the Schaeffler SmartCheck or ProLink device. This is possible both with the Schaeffler
SmartUtility Light software included in the scope of delivery and with the optional
Schaeffler SmartUtility software. Details on this can be found in the respective user
documentation.

· If you are using a proxy server between the browser and the internet in your company
network, you will need to adjust your browser's internet settings accordingly. To do so,
go to Internet Explorer and enter the address and port number of the proxy server under
Tools > Internet options. Please contact your system administrator for more detailed
information about proxy settings.

· Once the SmartWeb software is started, the system time of the Schaeffler SmartCheck or
ProLink device is compared with the computer time. The system time can be adjusted
if required.

· The SmartWeb software checks on a regular basis whether SmartUtility or SmartUtility
Light has new configurations. If so, the page is reloaded.

· If a Schaeffler SmartCheck or ProLink device cannot be opened in the browser, clear the
browser cache and try again.

· If you receive the message stating that cookies are not accepted, please allow the use of
cookies or enter the IP address of the Schaeffler SmartCheck or ProLink device as an
exception.

· If you are working on a computer with several Schaeffler SmartCheck or ProLink devices,
these devices should have identical firmware versions installed. If different firmware
versions are installed, this can have undesired effects within the browser.

154

http://www.schaeffler.de/condition-monitoring/smartcheckwww.schaeffler.de/en/condition-monitoring/smartcheck
http://www.schaeffler.de/condition-monitoring/smartcheckwww.schaeffler.de/en/condition-monitoring/smartcheck
http://www.schaeffler.de/condition-monitoring/prolinkwww.schaeffler.de/en/condition-monitoring/prolink
http://www.schaeffler.de/condition-monitoring/prolinkwww.schaeffler.de/en/condition-monitoring/prolink


8

3 The user interface at a glance

· If the browser window is closed by mistake or the connection to the Schaeffler
SmartCheck or ProLink device is interrupted, any settings that you have not yet confirmed
with OK will be lost. Consequently, always check whether the last change you made via
the user interface of the software has actually been adopted.

· If you do not make any changes for more than an hour in the SmartWeb software, you
are automatically logged out. You can edit the automatic log-off time .

The user interface of the Schaeffler SmartWeb software can be divided as follows:

The user interface offers you these options:

Title bar
The following information can be found in the right-hand corner or the tit le bar:

Connected to: Here you will find the name of the SmartCheck or ProLink device.

Logged in as: Here you will find the user name under which you are currently logged in.

 (SmartCheck only): This symbol indicates which status the "Machine is running" measurement
condition has identified for the machine. Under Measurement conditions , you can set the criteria
for the "Machine is running" measurement condition for your machine. Depending on the status
determined, the following symbol is displayed:

§ : the "Machine is running" measurement condition is fulfilled: the machine is in operation.

§ : the "Machine is running" measurement condition is not fulfilled: the machine is not in operation.

: If this symbol is visible, at least one characteristic value is in learning mode.

9
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The user interface at a glance

: The square symbol shows you the alarm status of the SmartCheck or ProLink device; the symbol is
displayed in different colours according to the status:

§ Grey: No characteristic value has yet been measured.

§ Green: No alarm exists.

§ Yellow: One or several characteristic values have triggered a pre-alarm.

§ Red: One or several characteristic values have triggered a main alarm.

§ Alternating between grey and green: Learning mode is active for one of your measurement
jobs. 
If a pre-alarm or main alarm is triggered during learning, the alarm symbol indicates the respective
alarm status without flashing, i.e. it lights up continuously yellow or red.

Menu bar
The following options can be found in the menus:

File · Print page: This command prints the current view of the SmartWeb software.
Ensure that you have selected the option for page setup in your browser such
that the page is reduced to fit the page size when printing.

Find the corresponding option e.g. in Mozilla Firefox (Shrink to fit Page Width)
and also in Windows Internet Explorer (Enable Shrink-to-Fit) under File >
Page Setup.

· Log out: Use this command to log out of the SmartCheck or ProLink device.
The connection to the device is closed.

Edit The functions available in the Edit menu depend on your user rights. Under certain
circumstances, some functions are deactivated because you do not have the
authorisations for them.

· Change password: This command opens the corresponding area  in the
SmartWeb software. You can then change your password or the password of
the logged-in user.

· User management: With each of the commands in this submenu, the
corresponding area  in the SmartWeb software opens. You can then make
your changes.

· Device settings: With each of the commands in this sub-menu, the
corresponding area  in the SmartWeb software opens. You can then make
your changes.
You can also specify the following:

§ Edit security settings - Enter a password for data encryption. This password
is required if the measurement data downloaded with the SmartWeb
software is to be opened in SmartUtility.

§ Edit automatic log-off time: Here you can define that the current user is
automatically logged off in the SmartWeb software after a certain period of
inactivity. The automatic log-off function is activated by default and is set to
one hour. You can only configure the log-off function if the "Edit system
settings" user right is activated.

· No other user can access the software as long as you are
logged into the SmartWeb software.

· There is a potential security risk if you deactivate the log-
off function or set the time frame for logging out as too
long, because unauthorised third parties could access the
SmartWeb software.

· Create new measurement job: This command starts a wizard that guides you
through creating a new measurement job .

· Edit program settings: Here you can specify the following:

§ Units: Determine the system of units that the SmartWeb software should
use. Among other things, this setting affects the dialogues in which you must
select a unit.
- With ISO, international units are displayed, e.g. mm/s.
- With US, American units are displayed, e.g. mil/s.
- With All, both international and American units are displayed, e.g. mm/s and
mil/s.

160
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§ Language: When possible, the SmartWeb software is automatically launched
in the language that you have set for your browser. Here you can manually
set the language in which the interface of the SmartWeb software is to be
displayed.

Measurement
data

· Open measurement data display: Use this command to go to the
Measurement data  area.

· Download measurement data: Use this command to open a dialogue in which
you can select measurement data for download .

· Delete measurement data: Use this command to open a dialogue in which you
can select measurement data for deletion .

Go to With the commands in this menu, you can switch to those areas that you can also
control via the buttons under Areas, i.e. to Status , Measurement data , Live
view , Configuration  and User Management .

Help · Open Help: Use this command to open a link to the website of the SmartCheck
or ProLink device. You can open the SmartWebHelp from there under
Downloads.

· Update firmware : Use this command to open a dialogue in which you can
update the firmware.

· Select device restart : Use this command to open a dialogue in which you
can reset or restart the device. Using this dialogue you can also open the
Maintenance System of the device or reset the data partit ion. 

· Install Schaeffler Cloud Onboarding : this command opens a dialogue box
that allows you to connect the device to Schaeffler Cloud services.

· View Open Source Licences- this command opens a window with detailed
information about the third-party libraries used by the SmartCheck or ProLink
software.

· Open licence manager : Use this command to open the licence manager
window. In this window, you can view your existing licences or licence group
names and add licences or licence groups. You will not be able to use or see
functions in the SmartWeb software for which you do not have a licence.

· Version information: Use this command to open a window with detailed
information on the version of the SmartCheck or ProLink device, including factory
firmware, device ID and serial number.

The settings for units, language, and messages are stored as cookies. When you delete
cookies, these settings are also deleted in the SmartWeb software. Next time the
SmartWeb software starts, it will be using the pre-set units and the language set for your
browser again. Automatic messages are displayed again by default.

The language setting is also influenced by the Schaeffler SmartUtility Light or Schaeffler
SmartUtility software: If you open the SmartWeb software via the SmartUtility Light or
SmartUtility software, the language setting of the software is used.

Areas
These buttons take you to the different areas of the SmartWeb software. You can also log out of the
SmartCheck or ProLink device here:

Status: Detailed information on the system and on the status of the measurement jobs
and their characteristic values can be found here. You can see at a glance which
characteristic values have triggered an alarm and follow the activities of the SmartCheck or
ProLink device in the messages of the logbook.

Measurement data: The measurement data for specific characteristic values can be
displayed in this area. The display includes trends, time signals and spectral data.

Live view: The signals of the configured inputs can be displayed here in real time.

Configuration: This area is particularly significant when setting up a new SmartCheck or
ProLink device: This is where you create measurement jobs, configure inputs and outputs,

43
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The user interface at a glance

make basic device settings, and edit the databases for bearings and bearing manufacturers.
You will also find details about the modules of the ProLink system.

User management: Here you can create, delete and manage users and user groups, as
well as change your password or the password of the user currently logged in. In addition,
you will find in this area the functions for activating and deactivating user management.

Log out: Click on this button to log out of the SmartCheck or ProLink device and close the
SmartWeb software.

Actions
Here you will find the selected important actions, which are either possible in the current area or lead to
another area as a link. For example, if you have opened the Measurement data area, you will find the
following commands here: Show measurement jobs, Download measurement data and Delete
measurement data.

Items of the selected area
What you see here depends on the current area. For example, if you have opened the Configuration
area, you can select individual configuration items - such as Measurement Jobs or Measurement
Conditions - here and then view information about them in the main panel of the SmartWeb software
and make further edits.

Detailed information and editing functions for the selected items
If you have selected an item on the left, you will see detailed information on it in the main panel of the
SmartWeb software and can make further edits. What exactly is possible depends on your particular
selection.

Status bar
The status bar informs you e.g. whether your browser has already finished loading the selected new area.

You can use the separator between the overview columns on the left and the main panel
on the right to adapt the interface of the SmartWeb software to suit your requirements:

· Holding down the left mouse button, drag the separator to the left or the right to alter
the size of the respective surface.

· Click on the separator to hide the overview columns on the left. This enlarges the main
panel to fill the full screen width. Click again on the separator to restore the view.

At many points in the interface, items are displayed in a tree structure. To see subordinate

items, click on ; to hide them again, click on .

In some areas of the SmartWeb software, the information is presented in tables. You can
structure tables using the following functions:

· Columns as sort criteria: Set any column of a table as a sort criterion by clicking in the
column title. Click a second time to change the sort order, i.e. from ascending to
descending or vice-versa. The current sort order is displayed by the symbols  for
ascending and  for descending.

· Move columns: Move any column to another position in the table. To do this, click with
the left mouse button in the column title and hold down the mouse button. Then drag
the cursor to the position in the table you want the column to appear in future.

160
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3.1 Update firmware

How to update the firmware
1. From the Help menu, select the Update firmware option in order to open the corresponding window:

2. Click Browse to locate and select the firmware file.

3. Click OK to update the SmartCheck or ProLink device with the selected firmware. Click Cancel to close the
window without applying any changes.

· When the firmware is updated, all measurement data and configurations on the device
may be lost. Before updating, save everything by downloading measurement data and, if
applicable, configurations with the SmartUtility software. The taught-in alarm limits are part
of the configuration and are downloaded at the same time.

· The update can take several minutes. The status LED on your SmartCheck or ProLink
device will flash yellow and red alternately during this time. The following is very important
in this process:

o The power supply to the SmartCheck or ProLink device must not be interrupted.

o The Ethernet connection to the SmartCheck or ProLink device must not be
interrupted.

o The update must be fully completed.

The device is no longer functional if these conditions are not met!

· If a serious error occurs during a firmware update, the device is reset to the factory
firmware. You can find the version of your factory firmware under Help > Version
information.

· After you have performed the firmware update, empty the browser cache. This is
necessary to ensure that the latest version of the Schaeffler SmartWeb software is loaded
in your browser.
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The user interface at a glance

3.2 Select device restart

To select the device restart, proceed as follows
1. From the Help menu, select the Select device restart option to open the corresponding window:

2. Select the required option from the list box:

Restart device This option restarts the SmartCheck or ProLink device:

· Current measurements are interrupted.

· Existing measurement data, configurations and the firmware are retained.

Start the device's
Maintenance System

You use this option to start the Maintenance System of the device. Here you will
find extensive maintenance functions, including for firmware update, device
configuration and system back-up. The Maintenance System also contains further
options for restarting the device.

When User management is activated , a logon dialogue
appears first. You can only log on to the Maintenance
System as an administrator and using the administrator
password.

Reset 
data partition

This option resets the data range:

· All existing measurement data is lost.

· Firmware and configurations, including taught-in alarm limits, are retained.

161
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Restore factory 
default setting

This option restores the SmartCheck or ProLink device to the factory default
setting:

· All existing measurement data is lost.

· All taught-in alarm limits are deleted.

· All configurations are lost.

· The firmware is reset to the factory default firmware.

To save measurement data, taught-in alarm limits and configurations, download the
measurement data and configurations with the SmartUtility software before you
restore the factory default setting. The taught-in alarm limits are part of the
configuration and are downloaded at the same time. After restoring the factory
settings, the Schaeffler SmartCheck or ProLink device can be reached at the IP
address defined by you.  Cancel closes the window without making any changes.

3. Click OK to reset the SmartCheck or ProLink device with the selected option.

Ensure that the device is accessible and then install the latest firmware.

3.3 Add licences or licence groups

Some features of the SmartWeb software require additional licences or licence groups. For example, you can only
set up the communication channel for email  with an additional licence. You will receive an additional licence or
licence group by email and can be added via the licence manager. Open the licence manager in the Help menu
using the Open licence manager option:

You can find a list of licences that are installed on your SmartCheck or ProLink device here, including the following
information:

Licence name Here you can find the name of the licence. The name refers to the function that is
enabled by the licence. Possible licence names and the functions that they enable are
as follows:

· Channel Monitoring: Using the Channel monitoring  measurement job
template

· OPC/UA: Setting up and using the OPC UA server communication channel

· Email: Setting up and using the email communication channel   

· Schaeffler Cloud: Setting up and using the Schaeffler Cloud communication
channel and access to the Schaeffler Cloud .

Valid from/valid until This data indicates the period of time for which the licences are valid.

105
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141
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The user interface at a glance

As of firmware version 1.28, the Channel Monitoring, OPC/UA and Email functions are
enabled by default.

How to add licences or licence groups
1. From the Help menu, select the Open licence manager option to open the corresponding window:

2. Click on the Add button. The Add licences or licence groups window opens.

3. Open the TXT licence document that you received by email in a text editor.

4. Copy the content of the document to the clipboard.

5. Click in the text area of the Add licences or licence groups window and paste the document content from
the clipboard.
A message informing you about the valid licences and licence groups contained in the pasted document appears
below the text area:

6. Click on Add. The licence or licence group you added appears in the overview of the licence manager window.

How to delete licences
Select the corresponding licence in the licence manager, click on Delete  and confirm with OK.
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3.4 Connect Schaeffler Cloud services

If you want to connect the SmartCheck device or ProLink device to the Schaeffler Cloud services, you need a
configuration file. Further information on this can be found here.

This is how you create a connection to the Schaeffler Cloud services
1. From the Help menu, select the Install Schaeffler cloud onboarding option to open the appropriate

window:

2. Click on Browse to locate and select the configuration file .

3. Click on OK to save the new input. Click on Cancel to close the window without applying any changes.

This step automatically creates the Communication channel for the Schaeffler Cloud  and makes all necessary
settings for data transmission. If necessary, you must adjust the proxy settings .
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https://www.schaeffler.de/content.schaeffler.de/de/news_medien/mediathek/publikationen/downloadcenter-global-pages/downloadcenter-language-list-publications.jsp?pubid=87649857&ppubid=87649858&tab=mediathek-pub&subfilter=app:dc
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4 Maintenance system of the device

The maintenance system of the Schaeffler SmartCheck or ProLink device provides you with comprehensive
maintenance functions. You can use this system, for example, to update the firmware, configure the SmartCheck or
ProLink device, to back up a system, or to restore a system from back-up. You can also use the latter function to
duplicate devices. The Maintenance System also offers securely protected expert functions for updating the
Maintenance System or for deleting the entire system on a SmartCheck or ProLink device among other things.

The Maintenance System is only available in English. It is independent of the actual firmware on the device and can
also be accessed via the browser, for example, if a firmware update has not run correctly.

To open the Maintenance System of the SmartCheck or ProLink device, proceed as follows:
1. From the Help menu, select the Select device restart option to open the corresponding window:

2. From the drop-down list, choose the option Start the device's Maintenance System.

3. Click on OK. The log-in page for the Maintenance System is displayed:

4. Click on the Login  button to open the start page of the Maintenance System. Use the Expert Menu
  button to directly access the Expert menu .
If user management is activated in the SmartCheck or ProLink firmware, a log-in dialogue appears in which you

28
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are required to log in as an administrator using the administrator password. If user management is deactivated,
the start page opens directly:

5. On the start page, click on an icon to select the relevant function. Depending on the function you choose, you
will then need to perform further steps or select sub-functions in a submenu. For information on the individual
functions of the Maintenance System, see the following sections.

· If the Maintenance System is started, the SmartCheck or ProLink device interrupts all
measurements.

· If you have opened a function of the Maintenance System, the Homepage button is
displayed at the top right. Click on this button to return to the start page of the
Maintenance System.

· The Maintenance System has a timer function: if you do not make any changes for a
certain period of time, the device is automatically restarted. The length of time depends
on where you are in the Maintenance System:

§ Login page of the Maintenance System: restart after 2 minutes

§ Start page of the Maintenance System and all function pages: restart after 10 minutes

§ Login page of the expert menu Expert Menu: 60 minutes

The remaining time until the device restarts is always displayed at the bottom right.

4.1 Update firmware

Click on the button Update firmware to start this function. You can update your system with a new firmware
version here. This does not delete the measurement data.
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Depending on the version of your firmware, you can also use this function to downgrade to
a previous firmware version. In this case, the measurement data is also deleted.

The option to downgrade is available as follows:

· Up to the release of SmartCheck version 1.10.0 or ProLink version 1.18.0: Downgrading to
previous versions is possible

· From the release of SmartCheck version 1.10.0 or ProLink version 1.18.0: Downgrading is
possible only up to version 1.10.0 or 1.18.0

How to update the firmware

1. Click on the Select file  button and search for the SF2 file containing the required firmware.

2. Open the SF2 file. The system analyses the file and informs you whether the update is possible, and if yes,
which firmware will be installed:

If the selected file is not a valid firmware file, you will be informed of this too.

3. Click on the OK button to start the update.
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· When the firmware is updated, all measurement data and, in some cases, also the
configurations on the device are lost. Before updating, save everything by downloading
measurement data and, if applicable, configurations with the SmartUtility software. The
taught-in alarm limits are part of the configuration and are downloaded at the same time.

· The update can take several minutes. The status LED on your SmartCheck or ProLink
device will flash yellow and red alternately during this time. The following is very important
in this process:

o The power supply to the SmartCheck or ProLink device must not be interrupted.

o The Ethernet connection to the SmartCheck or ProLink device must not be
interrupted.

o The update must be fully completed.

The device is no longer functional if these conditions are not met!

· If a serious error occurs during a firmware update, the device is reset to the factory
firmware. You can find the version of your factory firmware under Help > Version
information.

· After you have performed the firmware update, empty the browser cache. This is
necessary to ensure that the latest version of the Schaeffler SmartWeb software is loaded
in your browser.

4.2 Reset data partition

Click on the button Reset data partition to start this function. Here you can reset the data partit ion. This
deletes all measurement data from the system. The measurement configurations are retained.

Click on OK to reset the data partit ion.

4.3 Reset firmware

Click on the Reset firmware  button to start this function. Here you can format the data partit ion. In this
process, all measurement configurations and measurement data of the system are deleted and the default
measurement configuration is restored.

Click on OK  to reset the firmware.
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4.4 Adjust system settings

Click on the Adjust system settings button to open the menu containing the system setting functions:

Click on one of the buttons to open the corresponding function. The following sections contain more information
about the individual functions.

4.4.1 Edit system name

Click on the Edit system name  button to start this function. Here you can define a new name for your
SmartCheck or ProLink device.

To edit the system name, proceed as follows:
1. In the input field, enter the new name for your SmartCheck or ProLink device:
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2. Click on OK  to confirm the name.

4.4.2 Configure NTP server

Click on the Configure NTP server  button to start this function. Here you can define an NTP server from which
the SmartCheck or ProLink device can obtain the system time.

To configure the NTP server, proceed as follows:
1. Enter the IP address of the NTP server or the NTP server name in the input field:
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2. Click on OK to confirm the IP address or the NTP server name.

· If you use the NTP server name, you must enter a DNS server or set it using DHCP.

· If the system time is based on an NTP server, synchronization runs constantly. For this
method, therefore, the SmartCheck or ProLink device must have a permanent connection
to the network, and the NTP server must always be accessible.

4.4.3 Change administrator password

Click on the Change administrator password  button to start this function. Here you can change the
administrator password for user management.

To change the administrator password, proceed as follows:
1. Enter the new password in the field Administrator password.

2. Repeat this password in the field Reenter password:
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3. Click on OK to confirm the new password.

If you enter an administrator password here, user management  is activated automatically
on the SmartCheck or ProLink device.

If you do not enter an administrator password here, user management is deactivated on the
SmartCheck or ProLink device.

4.4.4 Configure IPv4 settings

Click on the Configure IPv4 settings  button to start this function. Here you can edit the IPv4 network
settings.

To edit the IPv4 network settings, proceed as follows:
1. Select the required DHCP mode from the list DHCP mode:

160
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You have the following options:

No DHCP With this option, you can specify the IPv4 address or continue to use the
default IP address of the SmartCheck or ProLink device.

If No DHCP is activated, you must also specify the other settings in this step,
e.g. IP address, Netmask or Gateway.

DHCP: Send host name to
server

With this option, the SmartCheck or ProLink device automatically receives an IP
address within your network. The host name is registered by the SmartCheck
or ProLink device in the network's DNS server.

DHCP: Load host name from
server

With this option, the SmartCheck or ProLink device automatically receives an IP
address within your network. The host name is specified via the network's DNS
server.

2. Depending on the selection for DHCP mode, you will need to make further entries under Host name, IP
address, Netmask, Gateway, or Name server.

3. Click on OK to confirm the changes and return to the system settings menu.

· If you change the IP address of the SmartCheck or ProLink device, you no longer have
access to the SmartWeb software at the previous address. You must then enter the new
address of the device in the browser in order to load the software and the Maintenance
System again.

· If the IP address is allocated automatically via DHCP, the SmartCheck or ProLink device can
only be accessed via the automatically allocated IP address or using the host name (DNS).
You can no longer use the default IP address.

4.4.5 Configure IPv6 settings

Click on the Configure IPv6 settings  button to start this function. Here you can edit the IPv6 network
settings.



26

To edit the IPv6 network settings, proceed as follows:
1. Select the required DHCP mode from the list DHCP mode:

You have the following options:

No DHCP With this option, you can specify the IPv6 address or continue to use the
default IP address of the SmartCheck or ProLink device.

If No DHCP is activated, you must also specify the other settings in this step,
e.g. IP address, Netmask or Gateway.

DHCP: Load host name from
server

With this option, the SmartCheck or ProLink device automatically receives an IP
address within your network. The host name is specified via the network's DNS
server.

2. Depending on the selection for DHCP mode you will need to make further entries under IP address,
Netmask, Gatewayor Name server.

3. Click on OK to confirm the changes and return to the system settings menu.

· If you change the IP address of the SmartCheck or ProLink device, you no longer have
access to the SmartWeb software at the previous address. You must then enter the new
address in the browser in order to load the software again.

· If the IP address is allocated automatically via DHCP, the SmartCheck or ProLink device can
only be accessed via the automatically allocated IP address or using the host name (DNS).
You can no longer use the default IP address.

4.4.6 Replace server certificate (PEM)

Click on the Replace server certificate (PEM)  button to start this function. Server certificates are used for
authentication of the server by the client. Here you can replace the server certificate that is defined on the
SmartCheck or ProLink device with your own server certificate.
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To replace the server certificate of the SmartCheck or ProLink device, proceed as follows:

1. Click on the button Server certificate file  and search for the PEM file containing the required server
certificate.

2. Open the PEM file and, if necessary, enter the password for the PEM file in the field Passphrase:

3. Click on OK to upload the certificate. The system analyses the file and informs you if can install the file:

If the file does not contain a valid server certificate, you will be informed of this too.

4. Click on OK to install the server certificate.
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4.5 Download debug log files

Click on the button Download debug log files to start this function. Here you can create and download an
error log file. You cannot view this file yourself. You need to send it to our Support team where it can be analysed.

To download the log files, proceed as follows:

1. Click on OK to start the action.

2. The error log file is downloaded. A progress bar informs you of the progress.

3. Your browser prompts you to save the file. Confirm this prompt. You can then find the error log file *.SCLG in
the standard download folder.

4.6 Open expert menu

Click on the Open expert menu  button to start the secure log-in process for the expert menu.

The expert menu contains functions that you can use to change the basic settings of the Schaeffler SmartCheck or
ProLink device. Because these are system-critical settings, the expert menu can only be opened via the secure log-
in process with a single-use password. The following section contains information about the secure log-in process.

To perform the secure log-in process, proceed as follows:
1. On the start page of the log-in process, you will find an ID. Share this ID with our Support team, e.g. by email or

telephone.

2. Our support team will use this ID to generate a single-use password and will forward this to you.

3. Click on the Login  button to open the authentication page; enter the user name in the User Name field and
the single-use password in the Password field:
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4. Click the OK  button. The expert menu home page is displayed:

Click on one of the buttons to open the corresponding function. The following sections contain more information
about the individual functions in the expert menu.

· The ID and the single-use password are only valid while you remain in the maintenance
system. As soon as you restart the SmartCheck or ProLink device, the ID and password
are no longer valid. When you restart the maintenance system, a new ID then becomes
valid, and you can use this to request a new password from support.

· On the homepage for the log-in process, you have 60 minutes to obtain the single-use

password from support. During this time, if you use the  button to switch to the
maintenance system and from there back to the home page of the log-in process, the
timer is reset to 60 minutes.

4.6.1 Reset administrator password

Click on the button Reset administrator password to start this function. Here you can reset the
administrator password to the factory default setting. All users can then log on without a password and have
administrator rights. This deactivates user management.

Click on OK to reset the administrator password.
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Use the Change administrator password  function to change the administrator
password. To find this function, choose Adjust system settings in the main menu of the
Maintenance System.

4.6.2 Replace cryptographic keys

Click on the button Replace cryptographic keys to start this function. The cryptographic keys are used to
decode firmware files (*. SF2) and back-up files (*.SCBK) and for encoding back-up and protocol files. If they have
become known due to a cyber attack, they must be replaced. This ensures that no harmful software can be
installed on the system.

To replace the cryptographic keys, proceed as follows:

1. Click on the button Keystore  and search for the file containing the cryptographic keys.

2. Open the file:

3. Click on OK  to upload the cryptographic keys. The system analyses the file and informs you if can install the
file:

23
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If the file does not contain any valid cryptographic keys, you will be informed of this too.

4. Click on OK to install the new cryptographic keys. 

4.6.3 Clear entire system

Click on the button Clear entire system to start this function. Here you can delete the entire system including
firmware, configurations and measurement data. The Maintenance System remains unaffected by this function.

1. Click on OK  to delete the entire system. The system is deleted and you then receive the following
message:
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2. You must now install new firmware. You also need to reconfigure the IP address of the SmartCheck or ProLink
device, because it has been reset to the standard IP address by this action.

After you have used the action Clear entire system, no firmware is available on the
SmartCheck or ProLink device. You have the following options to continue working with the
device:

· Load a new firmware file onto the device using Update firmware .

· Choose Restore system  to load a previously created back-up file containing the entire
system onto the device.

If you have enabled additional functions through licences, you will need to add the licences
again  .

4.6.4 Start remote access service

Click on the button Start remote access service to start this function. Using this function, our Support team
can assist you via an FTP/Telnet server in the Maintenance System. As soon as you restart the SmartCheck or
ProLink device, the Remote Access Service (RAS) is terminated.

To start remote access via RAS, proceed as follows:

1. Click on OK  to start remote access via RAS.

2. The system reports that RAS has started successfully:
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4.6.5 Update Maintenance System

Click on the button Update Maintenance System to start this function. Here you can upload an SM1 file to
update the Maintenance System.

To update the Maintenance System, proceed as follows:

1. Click on the Maintenance system file  button and search for the SM1 file containing the required
Maintenance System.

2. Open the SM1file. The system analyses the file and informs you which version of the Maintenance System it
contains:
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If the selected file does not contain a Maintenance System, you will be informed of this too.

3. Click on OK  to update the Maintenance System.

For this function, ensure a functioning power supply and an uninterrupted connection to the
SmartCheck or ProLink device. If problems occur during the update, send the device to our
Support team.

4.7 Backup system

Click on the button Backup system to start this function. Here you can create a back-up file of your system in
order to save firmware, configurations and data. You can then use the Restore system  function to select and
load a back-up file to restore a system, or to duplicate devices, e.g. to load configurations on multiple SmartCheck or
ProLink devices.

To back up your system, proceed as follows:
1. Select the required back-up type from the selection list:

35
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You have the following options:

Firmware with
configurations
(without data)

You can use this option to save the firmware and the configurations of the
system. The measurement data is not saved.

Firmware with
configurations and data

You can use this option to save the firmware, configurations and measurement
data of the system.

2. Click on OK to confirm the selected type of back-up and start the action.

3. The back-up file is downloaded. A progress bar informs you of the progress.

4. Your browser prompts you to save the file. Confirm this prompt. You can then find the back-up file *.SCBK in
the standard download folder.

Depending on the data volume, if you use the option Firmware with configurations and
data the file can become very large and the download therefore may take a long time.
During the download, the timer function is repeatedly reset to 10 minutes and does not
expire.

4.8 Restore system

Click on the button Restore system to start this function. Here you can select a previously created back-up
file  to restore a system. The back-up file either contains only the firmware and configurations, or it contains the
entire system (firmware, configurations, and data). A back-up file can, for example, be loaded to a new SmartCheck
or ProLink device that will replace a previous device. In addition, you can also use a back-up file to copy a particular
system to multiple devices.

To restore the system, proceed as follows:

1. Click on the Select file  button and search for the SCBK file containing the required system.

2. Open the SCBK file. The system analyses the file and informs you which firmware the selected file contains:

34
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If the selected file is not a valid back-up file, you will be informed of this too.

3. Click the OK  button. You will then be prompted to enter more precise details for restoring the system:

You have the following options:

Replacement unit Select this option if you want to use the back-up file to load the system to a
replacement unit. If the selected back-up file also contains measurement data,
the option Restore measurement data too also appears (see below).

Additional unit Select this option if you want to use the back-up file to copy the firmware and
the configurations to other SmartCheck or ProLink devices.
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Restore measurement
data too

This option is only displayed

· if the selected back-up file also contains measurement data (in addition to the
firmware and configurations) and

· if you have selected the option Replacement unit.

Select this option to also restore the measurement data of the back-up file. By
default, this option is deactivated and the system is restored without
measurement data.

4. Click on OK  to confirm your selection and to start restoration of the system.

· If the Restore System function is cancelled after it has been started, there will no longer
be any firmware on the SmartCheck or ProLink device. When you start the SmartCheck or
ProLink device, the Maintenance System opens. You must then load new firmware onto
the device, for example, using the functions Update firmware or Restore system.

· When you create a back-up file, not all content is copied. A back-up file for instance does
not contain a network address. If you use Restore system to load a back-up file onto a
new device, the network address of the new device is retained.

4.9 Reboot system

Click on the button Reboot system to start this function. This function enables you to shut down and restart
the system. This shortens the time until the automatic restart specified by the timer function of the Maintenance
System .

Click on OK  to confirm the restart.

This function is available both on the start page of the Maintenance System and in the
expert menu.

18
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5 Status

Click on the Status  button to open the corresponding area. Here you will find a general overview of the status
of the SmartCheck or ProLink device:

You can find the following information here:

Status and context menu
Your measurement jobs and the corresponding characteristic values are listed here. The alarm symbols
show you at a glance:

· Non-critical measurement job 

· Measurement job with pre-alarm 

· Measurement job with main alarm 

· Non-critical characteristic value 

· Characteristic value with pre-alarm 

· Characteristic value with main alarm 

· Characteristic value without measured values

· Sensor fault 

To see the status of a characteristic value in the main panel of the area, click on the desired characteristic
value.

For each item in this list, you can right-click to open a context menu, where you will find the following
commands:

· Reset alarm
For individual characteristic values: Switch off the alarm for this characteristic value manually here. This
option is required if alarms for this measurement job are not automatically reset as soon as the
measured value drops below the alarm limit.

· Reset all alarms
For individual measurement jobs: Manually switch off the alarms of all subordinate items here.
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You can only reset alarms manually, e.g. via this context menu, if you made the
corresponding setting when creating or editing a measurement job in the Set Alarms
step: under Reset Alarms, you must activate the Manual option.

· Alarm settings
For individual characteristic values: Here you open a dialogue in which you can view and edit the alarm
settings for this characteristic value.

· Edit hour meter
for measurement conditions: Edit the value for the hour meter here. Details on the hour meter and
how it works can be found here .

· Start learning mode
For individual characteristic values: Start the learning mode for the selected characteristic value again
here. Details on the learning mode and how it works can be found here .

· Start learning mode for all
For individual measurement jobs: Start the learning mode again for all subordinate items for which the
learning mode is authorised. Details on the learning mode and how it works can be found here .

· Activate learning mode for all
For the whole device, for individual measurement jobs or characteristic values: Activate this option to
switch on the learning mode for all subordinate elements. Details on the learning mode and how it
works can be found here .

· Live view
For individual characteristic values: Switch here to the Live view  area. There you will see in real
time the signal used for the calculation of this characteristic value.

· Measurement data
Switch here to the Measurement data  area. There you can display the trends and time signals of
these measurement jobs/this characteristic value and carry out an initial analysis.

The commands available depend on which level in the tree structure the selected item is located and
whether you have the user rights for the desired action.

Actions
In this area, you will find the menu items Create new measurement job  and Show measurement
jobs . They allow you to create a new measurement job and to go straight to the detailed overview
of your measurement jobs via the corresponding wizards.

If you use one of these menu items, you will then be taken automatically to the Configuration area.

Here you will also find the menu item Edit the "Machine is running" measurement condition for
theSmartCheck device. This measurement condition is preconfigured when the device is shipped and
should be adapted to the requirements of your machine.

Characteristic value status
For the selected measurement job/characteristic value, the name, alarm status, time of last measurement
and an illustration showing the development of the measurement job/characteristic value are displayed
here in one view. The button in the Characteristic value status tit le bar and the two buttons before
the illustration provide direct access to important functions:

Click on this button to display the status indicator for the entire system.

Click on this button to open a dialogue for editing the alarm settings.

Click on this button to view the measurement data and carry out an initial analysis of trends and
time signals.

An additional illustration shows you how the characteristic values of the measurement job or an individual
characteristic value behave in terms of the pre-alarm and main alarm:

The grey column symbolises the current value of the characteristic value. Depending on where
it is positioned, it indicates the following:

· Green area: The measured value is unproblematic.

· Yellow area: The measured value has exceeded the threshold of the pre-alarm.

· Red area: The measured value has exceeded the threshold of the main alarm.

If the measured value significantly exceeds the main alarm limit, a small black triangle is displayed
above the bar:
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If the measured value is below the lower pre-alarm limit Signal always greater than, the small
black triangle is displayed below the bar. The characteristic value then has a pre-alarm:

In symmetrical signals, for example in the case of torques in different directions, negative values
are also possible. In this case, a yellow area for the lower pre-alarm and a red area for the lower
main alarm are also displayed below the green area:

If no measured values have yet been measured, a white area is displayed.

Click the alarm symbol next to the column to view details of that characteristic value.

System information
General information about the system is displayed here, e.g. when the system was started, when the
configuration was last changed, when a measurement was last performed. You will also find the current
values for the individual inputs here.

For the Schaeffler ProLink device, the information about the processor module and all connected modules
are shown in illustrations:

The illustrations provide access to the following information and features:

The illustration furthest left provides information and functions for the
processor module of the ProLink device:

· Here you will find the start time of the device, time of the last
measurement and the last configuration change as well as the
available and remainingdisk space.

· Move the mouse over the illustration to read additional information
about the device temperature and the operating hours.

· Click on the illustration to open the device configuration
overview. Here you can define basic settings for your ProLink
device and specify measurement jobs.

The illustrations to the right of the processor module provide
information about the modules connected to your processor module:

· The modules are displayed in ascending alphanumeric order from
left to right. The combination of module name - for example
ProLink I/O module or ProLink vibration module - and serial number
determines the sequence. You should take this into account at
installation of the modules. To change the sort order and map your
physical system configuration, you can edit the names of the
modules .
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· For each module, you will find the current values for the four
analogue and two digital inputs here, as well as the current values
for the four digital switching outputs.

· You will find here the current values of the eight inputs or outputs
for each I/O module.

· Move the mouse over the illustration to read additional information
about the firmware version, hardware version, device
temperature and operating hours.

· Click on the illustration to open the module configuration .
Here you can view details for the respective module and edit its
name.

·  Status and module identification: The colour of the symbol
indicates the status of the device:
Green: The device is connected.
Grey: The device is not connected.
Flashing green and grey: The device is being identified.
You can identify the associated physical module by clicking on the
symbol. The LEDs of the physical module in question flash
alternately. Click again to exit identification mode.

To calculate the characteristic values, the measurement triggers and the measurement conditions, the
root mean square (RMS) value is calculated from a specified number of measurement values. The squaring
process means that this value is always positive, even if the measurement values are smaller than zero:

Example for measurement trigger: At a measurement range of -3000 rpm to +3000 rpm, if you
set a threshold of 1500 rpm with a rising edge, this threshold is triggered both when the value
exceeds +1500 rpm and when it falls below -1500 rpm.

Example for measurement condition: At a measurement range of -3000 rpm to +3000 rpm, if
you set a lower threshold of 1500 rpm and an upper threshold of 2000 rpm, this condition is met
both when the value is between +1500 rpm and +2000 rpm and when it is between -1500 rpm
and -2000 rpm.

Logbook
This table contains all messages created by the system or by users of the system, including dates on
which the system was created or changed and the level of the message. You have the following options:

· Browse messages
If your messages are spread over several pages, you can use the navigation elements   and  
of the logbook to skip forward and back a page or jump to the start or end of the logbook.

· Show warnings only
The SmartWeb software displays all logbook entries, i.e. errors, warnings and information, by default.
You can filter the results to display only errors and warnings by removing the checkmark from
Information. If you also deactivate Warnings, only errors are displayed.

· Add message
Click on  to create a new message. You can find details on this in the Create Message in the
Logbook  section.

· Edit messages
You can edit messages you created yourself. To do so, click on  in the Edit column. A window
opens, in which you can change the text in the Message field. Confirm your change by clicking on OK.

The categories of the messages created automatically by the system have the following meaning:

Information refers to events in the system; this includes e.g. a user having logged on or a
configuration having been changed.

Warnings are mostly references to misconfigurations, e.g. when a machine exceeds the
maximum rotational speed specified in the measurement job.

Errors report system-critical problems. In this case, contact our Support team.
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5.1 Creating/editing a message in the logbook

How to create a message in the logbook

1. Click on  to open the Add message window:

2. Select the Category for your message.

3. Enter the text of your message in the Message field.

4. Click on OK to save your message. The Logbook will now include the message.

How to edit a message in the logbook

1. In the line of the message you want to edit, click on Edit .

2. Make the desired specifications for Category and under Message.

3. Click on OK to accept your changes.
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6 Measurement data

Click on the Measurement data  button to open the corresponding area. Here you can view the trends and
time signals of characteristic values and the trends for measurement triggers and conditions, and you can carry out
an initial analysis. On the left, you will find your measurement triggers and conditions, and also the measurement
jobs and their characteristic values. If you select an item, you will see the associated trends and saved time signals in
the main panel. As soon as you select a saved signal, the corresponding curve appears:

As soon as you have selected a characteristic value and a saved time signal, you will find the following information
and functions here:

Trend
Under Trend, you will find a graph of the trend values for the selected characteristic value. On the left,
you will find precise information on the characteristic value and the save period under Name, Template
and Range.

As well as the trend (blue) and the saved time signals, the pre-alarm limits (yellow) and the main alarm
limits (red) are also depicted in the graph:

How to work with the graph:
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Highlighted in colour The section highlighted in colour tells you about the alarm status at a
glance:

· White: no alarm

· Yellow: pre-alarm

· Red: alarm

If the background is grey, a characteristic value error has occurred.

Blue line The blue line represents the trend.

Red line The red line represents the main alarm limit. Changes in the line occur

· If you have changed the value for the limit

· If the system has learned a new alarm limit via Learning mode

· If a new status area was reached in relation to Alarm maps .

Yellow line The yellow line represents the pre-alarm limit. Changes in the line occur

· If you have changed the value for the limit

· If the system has learned a new alarm limit via Learning mode

· If a new status area was reached in relation to Alarm maps .

If you place the cursor at certain places in the graph, a mark appears and
you can then read the corresponding values in the Date and Value fields.
You have this option:

· At the starting points of the trend and of the alarm limits

· At the end points of the trend and of the alarm limits

· At the changing points of the alarm limits

· At all measurement points of the trend (blue and green symbols).

On the blue trend line, you will find the following symbols:

· Blue: trend value

· Green with white centre: trend value with saved time signal; click on
the symbol to display the time signal.

· Red with white centre: time signal currently displayed

Additional options

 and Use this button to activate/deactivate the update mode.

If the update mode is activated, the trend is reloaded every 60 seconds
and new measurement values appear automatically in the trend window.

If you select in the trend window a trend range in which the last measured
value no longer appears, the update mode automatically deactivates.

Click this button to open a dialogue in which you can view and edit the
alarm settings for the relevant characteristic value .

· The trend display for measurement triggers and measurement conditions enables you to
check if and when the value that you have defined as the trigger or condition has been
encountered.

· If you select a time segment with very many time signals, it is possible that not all of them
will be displayed. In this case, you will only see a selection; if you zoom in on the area, the
"hidden" time signals will also appear.

· You can find detailed explanations on the learning mode and on alarm maps in the
Learning mode and alarm maps  section.

Saved time signals
Here you will find on the left a list of all saved time signals of the trend segment currently displayed,
each with details on the alarm status, date and value.
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· Click on a time signal in the list to see details about it below the list and in the graph on the right.

· When you have selected a time signal, you can use the arrow keys to navigate up and down through
the list.

· To sort the list, click on a column header.

· If you have zoomed in on a saved time signal as described below, the zoom range also remains in
place if you select a different time signal from the list.

By default, the graphical display on the right shows an overview of the saved time signal as a time
signal and as a spectrum. Here you can also perform an initial analysis:

You have the following options:

· Select the range . This determines whether the signal is displayed only as a time signal, only as a
spectrum or whether both graphics are visible.

· Activate the Fixed option to display the signal with fixed scaling. You can then zoom both horizontally
and vertically.

· You can view the exact values for each peak; move the cursor over the peak until a blue circle appears.
The values of this peak are then displayed in a small box:

· Activate a measurement tool by clicking on any point: when you click, a red cross appears on the
point. You can then drag a red line over the graphic. The values of the points and their distance to
each other can now be seen in a box next to the line:
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· If you zoom into a sub-area, as described below, the narrow strip beneath the main graph acts as an
overview: The full area is always shown here and the zoomed area is highlighted in colour.

Additional functions in the spectrum
For the spectrum view, the following additional functions are available:

· Activate the Log. option above the graphic  to display the signal with a logarithmic scaling.

· Select the required unit from the selection list below the graphic.

· The button  above the graphic opens the Edit speed/frequency band display dialogue. Here you
can edit the display of speed, harmonics and frequency bands:

You have the following options:

· Speed source: Choose between Do not display speed, Fixed speed, and User-defined. The
speed is displayed in dark red.

· Rotational frequency (RPM): If you have selected the User-defined option for speed source,
enter the required rotational frequency here. You can also enter the speed automatically: To do this,
move the cursor over a peak and double click when the blue circle appears. The corresponding speed is
then copied to the dialogue.

· Harmonics: Here you determine how many harmonics are displayed in the graphic. Harmonics are
displayed in light red.

· Frequency bands: Choose between Do not display frequency bands and the frequency bands
relevant for the selected characteristic value. Frequency bands are displayed in green

When you have set the speed, harmonics, and frequency bands, the spectrum might look as follows, for
example:
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In confidential measurement jobs  only users with special rights can edit the frequency
band display.

Zoom functions in all graphs
It is possible to zoom in on all graphs: To zoom, click in the graph and draw the cursor over the area on
which you want to zoom in while holding down the left mouse button; this highlights the zoomed area in
colour. You can also find details on this function here .

The following buttons are then available for you to work with zoomed areas:

Switches back to the original display

Jumps back a step in your zoom editing

Enlarges the selected time range

Jumps forward a step in your zoom editing

Actions
On the left under Actions, you will find the following menu items:

· Show measurement jobs : Use this link to jump directly to the Measurement jobs area. There
you will find an overview of all measurement jobs, their characteristic values and the corresponding
details.

· Download measurement data:  Use this command to open a dialogue in which you can select
measurement data for download.

· Delete measurement data:  Use this command to open a dialogue in which you can select
measurement data for deletion.

· The Measurement data area is only designed for an initial analysis. For a detailed analysis,
you must download the data of the SmartCheck or ProLink device . You can then use
the built-in SmartUtility Viewer software to perform a more detailed analysis. 

· The details in the Saved time signals section also contain information on the number of
measurement values. However, the actual number of measured values displayed depends
on the limitations of your browser.
If you are using Internet Explorer, the whole time signal cannot be displayed for
performance reasons. You can identify the actual number of measured values displayed
under Number of values. Two values are displayed:

In this example, only 2048 of 4096 measured values are displayed.

6.1 Edit alarm settings

The alarm settings for a characteristic value are initially set as part of a measurement job . You have access to a
dialogue in which you can edit the alarm settings at a later point.

How to edit the alarm settings

1. In the Measurement data area, click .

2. In the Alarm settings window, enter the desired specifications:
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You have the following options:

Buttons and graphic · You can use the buttons above the graphic to navigate the trend and use zoom
functions. More details can be found in the Measurement data  section.

· The graphic shows you the trend of the selected characteristic value. The
graphic provides the same information and functions as the graphic in the
Measurement data area. You can find details on this in the Measurement
data  section.

· You can also adjust the alarm limits manually from here:

§ Main alarm: Click the red main alarm limit, hold down the mouse button and
drag the limit to the required position. The pre-alarm limit is automatically
dragged with it as soon as you go below the pre-alarm limit.

§ Pre-alarm: Click the yellow pre-alarm limit, hold down the mouse button and
drag the limit to the required position. This does not change the main alarm
limit and the pre-alarm limit cannot be dragged over the main alarm limit.

Main alarm This is where you determine the limit at which the main alarm is triggered.

Lower main alarm Symmetrical signals, for example for rotational movements in different directions,
also have negative values. Enter the main alarm limit for the negative value range.

Pre-alarm This is where you determine the limit at which the pre-alarm is triggered. Next to
the absolute value is the percentage value calculated from the pre-alarm limit and
main alarm limit.
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Lower pre-alarm Enter the pre-alarm threshold for the negative value range of a symmetrical signal.

Signal always larger
than

Enter a value for an additional pre-alarm limit. This pre-alarm is triggered when the
signal value is below the value determined here.

Use learning mode Activate this option to use the learning mode for this characteristic value. The
system can then automatically learn the alarm limits depending on the current
status of the machine. Learning mode can only commence if there is a tick here,
e.g. entered via the context menu of the characteristic value in the Status
area.

You can find details on the learning mode in the Learning mode and alarm
maps  section.

Move the mouse over the question mark  to read additional information.

3. Click OK to save the new alarm settings.

You can also edit the alarm settings for an alarm map here. In this case, you must edit the
alarm settings of the individual alarm maps.

6.2 Edit hour meter

When you create a measurement condition, an hour meter is automatically created which indicates the active
operating time of a measurement condition. This allows you to determine how long a measurement condition has
been satisfied and for example to track the running time of a pump.

The hour meter starts as soon as the corresponding measurement condition  is fulfilled.

Here you can view the trend of the hour meter and carry out an initial analysis.

How to edit an hour meter
1. Click on the Measurement condition under Measurement triggers and conditions in the Measurement

data area.

2. Click on Hour meter and make a selection from the shortcut menu .

3. Set the desired specifications in the Hour meter window:

38

85

102



50

The following options are available:

Values [hours] Here you can specify the hour value from which the hour meter should run. The
default setting is 0.

Adjust the hour meter if the component has been in operation for a long time and
you installed the monitoring at a later time. If you exchanged the component,
reset the hour meter back to 0.

3. Click OK to save the hour meter settings.

You can view the trend of the hour meter in the Measurement data area below the associated measurement
condition.

6.3 Download measurement data

The Measurement data area is only designed for an initial analysis. For a detailed analysis, you must download the
data of the SmartCheck or ProLink device. You can execute this using the Schaeffler SmartUtility software and
analyse the data directly using the integrated SmartUtility Viewer software. Alternatively, you can download the
measurement data using the corresponding function of the SmartWeb software and open it later in the
SmartUtility Viewer software for analysis. 

How to download the measurement data
1. In the Measurement data area, select the Download measurement data action.

2. In the Download measurement data window, enter the desired specifications:

You have the following options:

Entire measuring period Activate this option to download all saved measurement data.

Selected measuring
period

If you activate this option, the calendar functions become active:
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You can then use the list boxes or the calendar selection to determine the time
range for which the measurement data is to be downloaded.

3. Click on OK. You must then confirm the download of the *.scd1 or *.scd2 file to your downloads directory.

4. Once the *.scd1 or *.scd2 file has been downloaded, you must convert the data directory in the SmartUtility
software. You can then analyse the data in the Viewer software.

You can save downloaded files with a password for data encryption. The Edit > Device
settings > Edit security settings menu option opens a dialogue box in which you can
enter the password. This password is required if the measurement data downloaded with
the SmartWeb software should be opened in SmartUtility.

6.4 Delete measurement data

You can delete measurement data from your SmartCheck or ProLink device. In doing so, you can define both the
time range of the data to be deleted and the affected measurement jobs, measurement triggers and measurement
conditions.

How to delete measurement data from the SmartCheck or ProLink device
1. In the Measurement data area, select the Delete measurement data action.

2. In the Delete measurement data window, enter the desired specifications:
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You have the following options:

Complete time range Activate this option to use the entire measuring period as the basis for deleting
measurement data.

Specify time range If you activate this option, the calendar functions become active: you can then use
the list boxes or the calendar selection to determine the period for which the
measurement data must be deleted.

All measurement data Activate this option to delete all measurement data within the time range selected
above.

Define measurement
data

Activate this option to select specific measurement jobs, measurement triggers or
measurement conditions from the list. Only the measurement data in this selection
is then deleted for the time range selected above.

How to select items from the list:

· Left-click: selects the item.

· CTRL + left-click: Adds the item to an existing selection.

· SHIFT + left-click: Selects all items between the first and last selected items.

3. Click on OK. The measurement data corresponding to your selection is deleted.
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7 Live view

Click on the Live view button to open the corresponding area. Here you can view the relevant signal for each
input and the scaling factors  created for them. This allows you to check whether a valid signal is coming in,
whether you have connected and configured the inputs correctly and whether the SmartCheck or ProLink device is
working properly. You can also try out different filter settings for vibration sensors here. You create the basis for this
when creating a base measurement job: If you activate Expert settings  in the configuration wizard, you can
set filters in some measurement jobs in the corresponding step. 

As soon as you have selected an input or scaling factor on the left, you will find the following information and
functions here:

Live view settings
Various options here enable you to influence the display in the live view:

· Signal type: Here you can select which signal type should be displayed. If no selection is made, the
raw signal is displayed.

· Filter settings: Here you can modify the filters that are used.

· Measurement values: Here you can determine how many measurement values are displayed. The x-
axis display then changes accordingly. With the Number of values, you can specify the area in which
you can work with the navigation elements and the zoom function.

· Signal unit: Here you have the possibility to change the signal unit. In our example above, you can
change from acceleration and m/s2 to speed and mm/s or to displacement and mm.

Live view and navigation elements

To use the functions above and in the graphical display of the live view, proceed as follows:

Fixed Activate this option to display the signal with fixed scaling. You can then
zoom both horizontally and vertically.

Log. Spectrum only:

Activate this option to display the signal with logarithmic scaling.

Use this button to open the Edit speed/frequency band display
dialogue. Here, you can edit the display of speed, harmonics, and
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frequency bands.

Click on the graphic Clicking on the graphic activates a measuring tool  that you can use
to determine the distance between two points on the display.

Use the navigation elements to further analyse the live view as follows:

As soon as you move the slider, the live view is stopped; you can then
navigate with the slider through the last 50 measurements.

As soon as you click on Back, the live view is stopped and the display
jumps backwards in individual steps.

If you have stopped the live view and rewound, you can jump forwards
in individual steps by pressing the Forward button.

and

With these buttons, you can stop and resume the live view.

In confidential measurement jobs  only users with special rights can edit the frequency
band display.

Zooming in on the live view
You can have a closer look at areas of the live view by zooming in on them:

· Click in the area you want to look at and move over the area whilst holding down the left mouse
button. This highlights the zoomed area in colour:

· As soon as you release the mouse button, only the zoomed area appears in the live view. The thin strip
below shows an overview of the original display area, indicating the area that has been zoomed in on:
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· Further zoom functions  are available using the buttons above the graphic.

Actions
On the left under Actions, you will find the Open input configuration menu item, with which you can
jump directly to the Input configurations  area to edit the selected input.
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8 Configuration

Click on the Configuration  button to open the corresponding area. In this area of the SmartWeb software,
you can make basic settings for your SmartCheck or ProLink device and specify measurement jobs. The
Configuration is thus the core of your SmartCheck or ProLink device: How reliably the machine monitoring is
executed depends on the settings in this area.

When you use the Schaeffler SmartCheck or ProLink device for the first time, the configuration overview opens

automatically when you click on the Configuration  button:

This overview depicts what a logical work flow looks like once you have installed the SmartCheck or ProLink device
and established a connection to the SmartWeb software:

1. First you should set System parameters  such as device name and system time. These settings are not
relevant as regards measurement.

2. This step relates to the Signal inputs . The system inputs are already available with a base configuration.
However, if you would like to connect additional inputs, for example, a speed sensor, you should configure it
now. The system must know the additional inputs in order to correctly interpret the incoming signal. Moreover,
you can only use existing input configurations for measurement jobs (see below).

3. In the third step, create measurement jobs . Characteristic values are calculated via measurement jobs, which
give you information about the condition of the machine. A measurement job is already present for each
analogue input in the factory default setting of the SmartCheck or ProLink device, the Base measurement job.
You can also edit and adapt this measurement job to your own needs. A configuration wizard is available both
for the creation and editing of measurement jobs. 
For the SmartCheck device, in this step, you should also change the preconfigured "Machine is running"
measurement condition  to the requirements of your machine.

4. If you want to connect the outputs  of the SmartCheck or ProLink device to your controller, you must define
here for the SmartCheck device whether a characteristic value or an alarm status is to be output at the output.
For the ProLink device, you must define which alarm status is to be output at the output.
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You can open the configuration overview from every configuration area. To do so, click on

the Configuration overview  symbol in the top right.

In the expanded overview on the left, you will find all areas in which you can make settings:

Input configurations : Here you can configure the analogue and digital inputs of the SmartCheck or
ProLink device and additionally create scaling factors.

Measurement jobs : Here you can find an overview of your measurement jobs and the associated
characteristic value configurations. You can also create, edit or delete new measurement jobs here.
Different measurements are bundled in each measurement job, which are performed respectively at a
certain time or in a certain order.

Output configurations : Here you configure the analogue and the digital outputs of the system.

Measurement trigger : Here you specify when measurements should be started. If a measurement
trigger is fulfilled, the current measurement is immediately interrupted and the measurement initiated by
this particular measurement trigger is started.

Measurement conditions : Here you specify the conditions under which measurements are started.

Communication channels : Here you can create an email communication channel , integrate
external controllers , configure the SmartCheck or ProLink device as an OPC UA server  or configure
the PROFINET module  for connecting the ProLink device to a controller. The email communication
channel enables emails to be sent from the SmartCheck or ProLink device. Data from the integrated
controllers can be used in the SmartCheck or ProLink device or alarm statuses for characteristic values can
be transferred from the SmartCheck or ProLink device to these controllers. Other controllers can read out
process parameters of the SmartCheck or ProLink device via the OPC UA server communication channel or
provide the SmartCheck or ProLink device with additional process parameters via the OPC UA server inputs.
A controller can read data from the ProLink device connected to it and send process data to the ProLink
device via the PROFINET module. 

Device : In this area, you can view and partly change the main settings of the SmartCheck or ProLink
device. This includes e.g. the device name and the system time.

Bearings : Here you will find the bearing database, which you can expand yourself.

Bearing manufacturer : Here you will find a list of bearing manufacturers. You can add further
manufacturers to this list.

In each of these areas, under the Actions menu, you will find the item Create new
measurement job . This menu item starts a wizard, with which you create a
measurement job step by step. This task is also facilitated by virtue of measurement
templates , which are already available in the SmartCheck or ProLink device. They are
automatically incorporated by the wizard and support the creation of specific measurements.

8.1 Module configuration (ProLink only)

Schaeffler ProLinkYou can connect a maximum of four vibration modules and a maximum of four I/O modules to the
processor module. Once you have properly put the system into operation, the modules are automatically created in
the SmartWeb software and displayed in the individual areas as separate levels. In the tree, select a module to view
details, change its name and identify its physical module. For I/O modules, you can also define the inputs and
outputs here:
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If you select a vibration module in the expanded overview, you will find the following in the main panel:

· Name: Here you will find the full name of the module.
In the SmartWeb software, the modules are sorted alphanumerically in ascending order. The module name
determines the sort order. This affects details such as the system information  in the Status area. To

change the sort order and map your physical system configuration, you must edit the module name using .

·  Module identification: Click the symbol to identify the associated physical module. The LEDs of the physical
module in question flash alternately. Click again to exit identification mode.

· Below the name you will find more details about the module, such as the serial number, IP address or
temperature of the module.

· On the right, in the area highlighted in grey, you will find details on creating and changing the module.

· Click on  to edit the name of the module .
You can also define the inputs and outputs of the I/O module  via the same button.

· Click on  to open the configuration overview .

Here is how to edit the name of a module

1. Click on  to open the Edit module window:

You can make the following changes here:

Name The module is listed under this name in the SmartWeb software. Due to the alphanumeric
sorting sequence, the name determines where a module is placed in the respective list. You
can change the display of details such as the system information  in the Status area to
map your physical system configuration.
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2. Click on OK to save your changes.

This is how you define the inputs and outputs of an I/O module

1. Click on  to open the Edit module window:

You can make the following changes here:

Name The module is listed under this name in the SmartWeb software. Due to the alphanumeric
sorting sequence, the name determines where a module is placed in the respective list. You
can change the display of details such as the system information  in the Status area to
map your physical system configuration.

Channel 1-8 Select the required analogue or digital input or output for each channel of the I/O module.

You can then configure the inputs in the input configurations area and the outputs in the
output configurations area.

2. Click on OK to save your changes.

8.2 Input configurations

Depending on the system, you have the following options:

· Schaeffler SmartCheck device: The device has a vibration and temperature sensor , which supplies input
signals directly after commissioning. In addition, you can connect a total of three further external sensors via the
two analogue inputs  and the digital input  to the SmartCheck device and configure them here.

· Schaeffler ProLink device: Once you have started the Schaeffler ProLink device, the inputs for the connected
vibration modules  are automatically created and assigned to the modules. Four analogue inputs  and two
digital inputs  are possible per vibration module. You can configure these inputs here.
In addition, eight analogue inputs are automatically created for each of the connected I/O modules. You can
configure these inputs here. Use the module configuration to switch these analogue inputs to digital inputs,
analogue outputs or digital outputs.

You can find details on how to connect the SmartCheck or ProLink device properly in the respective user
documentation.

Moreover, the SmartCheck or ProLink device is capable of creating fixed values . Here, for example, you can
specify a constant speed in order to ensure the correct calculation of the characteristic values.

In the expanded overview on the left, you will find all inputs of the SmartCheck device. For the ProLink device you
will find all connected modules and associated inputs here. You can see details on the input currently selected along
with possible editing functions in the main panel under Input configurations:
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The information and functions you can access here depend on the selected input. Relevant details can be found in
the following sections.

8.2.1 Internal sensors (SmartCheck only)

In the factory default setting, the Schaeffler SmartCheck device has two internal sensors: a temperature sensor and
a vibration sensor. As soon as the system is properly commissioned, these two sensors supply signals and can be
incorporated into a Measurement job . In the Input configurations area, you can view and partly edit the
details on the corresponding inputs:

If you select the input of an internal sensor in the expanded overview, you will find the following in the main panel:

· The details on the selected input are shown on the left: Next to Input channel, you will find the name of the
physical connection: next to Name, you will find the name you yourself gave this specific configuration.

· On the right, in the area highlighted in yellow, you will find details on creating and changing the input.

· Click on  to edit the input configuration of the internal sensor.
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· Click on  to open the configuration overview .

How to edit the input configuration of an internal sensor

1. Click on  to open the Edit input configuration window:

You can make the following changes here:

Name The input is listed under this name in the Input configurations area. Therefore, you should
choose a practical name which will enable you to distinguish between several inputs.

Unit Here you can change the unit of measurement for the sensor signal. By default, the unit of
the corresponding input configuration is selected here.

2. Click on OK to save your changes.

8.2.2 Analogue inputs

The SmartCheck device has two analogue inputs. Each vibration module of the ProLink device has four analogue
inputs, which you can use either as a vibration input or as an analogue input with other signal sources, such as
torque or temperature sensors. Each I/O module of the ProLink device has up to eight analogue inputs that you can
configure flexibly

In the factory default settings, these are configured as follows:

SmartCheck device:

· Analogue 1 § Unit group: voltage

§ Signal unit: V

§ Input range: 0-10 V

· Analogue 2 § Unit group: load

§ Signal unit: %

§ Input range: 0-20 mA

§ Scaling factor: 5

Vibration module of the ProLink device:

· Analogue 1–4 § Input type: Vibration input

§ Unit group: acceleration

§ Signal unit: g

§ Sensor type: AC

§ Sensor sensitivity [mV/g]: 100

I/O module of the ProLink device:

· Analogue 1-8 § Unit group: voltage

§ Signal unit: V

§ Sample rate: 500 Hz

§ Input type: 0–10 V

In the Input configurations area, you can view and partly edit the details on the corresponding inputs:
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If you select an analogue input in the expanded overview, you will find the following in the main panel:

· The details on the selected input are shown on the left: next to Input channel you will find the name of the
physical connection; next to Name you will find the name that the system has automatically assigned (the ProLink
device only) or that you yourself gave this specific configuration.

· Beside the details, you will find a diagram illustrating the details. The diagram is automatically adjusted when you
edit the input configuration.
The diagram does not appear for vibration inputs.

· On the right, in the area highlighted in yellow, you will find details on creating and changing the input.

· Click on  to edit the input configuration of the analogue input .

· Click on  to add additional scaling factors  to the input; you can also access scaling factors e.g. when
creating measurement jobs .

· Click on  to open the configuration overview .

How to edit an analogue input configuration
1. In the expanded overview on the left, select the analogue input you would like to edit.

2. Click on Edit  in the main panel to open the Edit input configuration window.

For the SmartCheck device, you will see the following dialogue box:
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Configuration

You have the following options:

Name Here, specify the name that the input is to appear under in the SmartWeb
software.

Unit group Here, specify which physical value is measured by the sensor you are connecting
to this input, e.g. Frequency/speed.

Signal unit Here, select the appropriate unit of measurement for your sensor.

Input type Here, select the range of the voltage/current that applies for this input
configuration. The SmartCheck device supports the following ranges for the
analogue inputs:

· 0-10 V

· 0-24 V

· 4-20 mA

· 0-20 mA

Max, Scaling, Min Use these settings to determine the range within which the measurement values
should lie. First enter a minimum value Min. Then enter a maximum value Max or
define the factor with which the incoming signal should be scaled in the Scaling
field. Both the diagram and the values of the respective other field are then
adjusted automatically.
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For the vibration module you will see the following dialogue depending on the input type:

Input type: Vibration input Input type: Analogue input

You have the following options:

Name Here, specify the name that the input is to appear under in the SmartWeb
software.

Input type Select the appropriate input type for the connected vibration sensor:

· Vibration input
· Analogue input

Unit group Here, specify which physical value is measured by the sensor you are connecting
to this input, e.g. Frequency/speed.

Signal unit Here, select the appropriate unit of measurement for your sensor.

Sensor type
(vibration input only)

Select the appropriate sensor type for the connected vibration sensor:

· AC
· DC
· IEPE: Select this option for IEPE acceleration sensors.

Sensor sensitivity
(vibration input only)

Select the value specified on the calibration data sheet for the sensor.

Min./max. Bias voltage
(vibration input only)

Adjust this value for the IEPE acceleration sensor if necessary.

Voltage input
(analogue input only)

Here, select the range of the voltage/current that applies for this input
configuration. The ProLink device supports the following ranges for the analogue
inputs:

· 0 V to 10 V

· -10 V to 10 V

Low-pass
(analogue input only)

Select the value of the low-pass here.
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A 50 Hz low-pass is automatically applied, with which only relatively slow signals
can be measured. If you use the analogue input for a measurement trigger or a
measurement condition, this low-pass is also connected in between. When
selecting the measurement length, you must therefore expect 128 samples per
second.

Max, Scaling, Min
(analogue input only)

Use these settings to determine the range within which the measurement values
should lie. First enter a minimum value Min. Then enter a maximum value Max or
define the factor with which the incoming signal should be scaled in the Scaling
field. Both the diagram and the values of the respective other field are then
adjusted automatically.

Invert
(analogue input only)

Activate this option to invert the scaling factor.

Example: A combined vibration and temperature sensor delivers a value of 10 mV/°C. With
a voltage range from 0 V to 10 V, this yields a measuring range from 0 °C to 1000 °C. By
default, the scaling factor is set to °C/V. With Invert you can automatically change the
scaling factor to V/°C.

The following dialogue is displayed for the I/O module:

You have the following options:

Name Here, specify the name that the input is to appear under in the SmartWeb
software.

Unit group Here, specify which physical value is measured by the sensor you are connecting
to this input, e.g. Frequency/speed.

Signal unit Here, select the appropriate unit of measurement for your sensor.

Input type Here, select the range of the voltage/current that applies for this input
configuration. The I/O module supports the following ranges for the analogue
inputs:

· 0-10 V

· 0-20 mA

· 4-20 mA
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Max, Scaling, Min Use these settings to determine the range within which the measurement values
should lie. First enter a minimum value Min. Then enter a maximum value Max or
define the factor with which the incoming signal should be scaled in the Scaling
field. Both the diagram and the values of the respective other field are then
adjusted automatically.

3. Click on OK to save your changes.

· If you want to edit an input that is already used by a measurement job, measurement
condition or measurement trigger, you must first delete this associated configuration.

· You can also enter negative values for the Min and Max for an analogue speed input.
This enables you to distinguish between different directions of rotation.

· Analogue inputs that you create on the ProLink device can be added as an additional
characteristic value to a measurement job or used as an input for a measurement trigger,
a measurement condition or for channel monitoring. You cannot use these analogue
inputs directly for a vibration measurement job.

How to add a scaling factor to the input
You can add scaling factors to the analogue input, which you can access e.g. when creating a measurement job
. Using scaling factors, you can calculate logical values for other areas from the physical value measured at one area
of the component.

Example: With the analogue input, you measure the speed in front of the gear. The speed behind the gear
is 5 times smaller. You can create a scaling factor for this:
1. Speed in front of the gear
2. Speed behind the gear with a factor of 0.2 (1/5)

1. Click on  to open the Add scaling factor window:

You have the following options:

Name The scaling factor is listed under this name, along with the other inputs. Therefore,
you should choose a practical name that will enable you to distinguish between the
inputs.

Scaling factor The physical input signal is multiplied by the value you enter here.

Unit Here you can change the unit of measurement for the sensor signal. By default, the
unit of the corresponding input configuration is selected here.

2. Click on OK to save your changes. The new scaling factor appears in the diagram and in the list of scaling factors:

75
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3. To delete or edit the scaling factor, right-click to open the context menu and select the corresponding
command here:

If you delete a scaling factor which is being used by a measurement job, the system gives
you a warning message. If you delete the scaling factor, you also automatically delete the
relevant measurement job.

8.2.3 Digital input

The digital input of the SmartCheck device or the two digital inputs of each Schaeffler ProLink vibration module are
configured as follows in the factory default setting:

· Unit group: frequency/speed

· Signal unit: rpm (SmartCheck) or Hz (ProLink)

· Pulses per revolution: 1

· Signal threshold: 7 V

· Hysteresis: 2 V

SmartCheck device:
When selecting the dropping resistor, please note the impedance of the input signal of your
digital input. Note the maximum switching current of the digital switching output of the
Schaeffler SmartCheck device (1 A/30 V) and the power of the dropping resistor.
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With the Schaeffler ProLink I/O module you can create up to eight digital inputs . They are created with the
following values, which cannot be changed:

· Unit group: no unit

· Signal unit: -

· Sample rate: 500 Hz

· Pulses per revolution: 1

· Signal threshold: 3 V

· Hysteresis: 0.5 V

In the Input configurations area, you can view and partly edit the details for the digital input:

If you select the digital input in the expanded overview, you will find the following in the main panel:

· The details on the selected input are shown on the left: next to Input channel, you will find the name of the
physical connection; next to Name, you will find the name that the ProLink device has automatically assigned or
that you yourself gave this specific configuration.

· Beside the details, you will find a diagram illustrating the details.

· On the right, in the field highlighted in yellow, you will find details on the creating and changing the input.

· Click on  to edit the input configuration of the digital input .

· Click on  to add additional scaling factors  to the input; you can also access scaling factors e.g. when
creating measurement jobs .

· Click on  to open the configuration overview .

How to edit a digital input configuration

:For the digital inputs of the ProLink device, you can only change the name and the setting
for Inverted. If you need adjustable switching thresholds, you must use the speed input of
the Schaeffler ProLink vibration module.

1. Select the digital input in the expanded overview on the left.

2. In the main panel, click on Edit  to open the Edit input configuration window:
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You have the following options:

Name Here, specify the name that the input is to appear under in the SmartWeb software.

Unit group Here you have the choice between No unit and Frequency/speed. Select the option
No unit if you want the input to display a status such as "Machine on" or "Machine off".

Signal unit Here you will only find a list box if you have selected Frequency/speed as the Unit
group.

Inverted Activate this option to invert the digital input signal.

Signal type
(ProLink only)

Here you have the following options:

· Speed signal (excl. direction of rotation)

· A/B encoder (incl. direction of rotation)

Pulses per
revolution

This option is only available when Frequency/speed is selected as the Unit group.

Signal threshold Specify in volts the average input level, above or below which the digital input switches; in
the diagram, the Signal threshold is drawn in blue.

The specified value is rounded up/down to the nearest .0 or .5.

Hysteresis With Hysteresis, you specify in volts the range within which the input level is permitted
to drop below or rise above the Signal threshold without the digital input switching; in
the diagram, the Hysteresis is drawn in red.

The hysteresis should be set in every case, as otherwise the signal could generate
spurious pulses at the signal threshold. The poorer the signal, the higher you should set
the hysteresis.

The specified value is rounded up/down to the nearest .0 or .5.

Example: With a Signal threshold of 5 V and a Hysteresis of 2 V, the status of the digital input
remains unchanged between 4 V and 6 V.

Diagram The diagram illustrates how the input reacts to your settings, in other words how the
system converts real input pulses e.g. between 0 V and 12 V into digital 0 and 1; with
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each change, the diagram is immediately updated. The diagram in the example is
interpreted as follows:

The input signal (orange) passes the hysteresis line (red) above the signal threshold
(blue). The signal output (black) reacts to this and jumps from 0 to 1. As soon as the
input signal undercuts the hysteresis line below the signal limit, the signal output reacts
again and jumps from 1 to 0.

Example: Your sensor delivers pulses between 0 V and 12 V. In this case, set the signal threshold to
6 V and the hysteresis e.g. to 2 V.

3. Click on OK to save your changes.

How to add a scaling factor
You can add scaling factors to the digital input, which you can access e.g. when creating a measurement job .
Using scaling factors, you can calculate logical values for other areas from the physical value measured at one area of
the component.

Example: With the digital input, you measure the speed in front of the gear. The speed behind the gear is 5
times smaller. You can create a scaling factor for this:
1. Speed in front of the gear
2. Speed behind the gear with a factor of 0.2 (1/5)

1. Click on  to open the Add scaling factor window:

You have the following options:

Name The scaling factor is listed under this name, along with the other inputs. Therefore,
you should choose a practical name that will enable you to distinguish between the
inputs.

Scaling factor The physical input signal is multiplied by the value you enter here.

Unit Here you can change the unit of measurement for the sensor signal. By default,
the unit of the corresponding input configuration is selected here.

2. Click on OK to save your changes. The new scaling factor appears in the list of scaling factors:
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3. To delete or edit the scaling factor, right-click to open the context menu and select the corresponding
command here:

If you delete a scaling factor which is being used by a measurement job, the system gives
you a warning message. If you delete the scaling factor, you also automatically delete the
relevant measurement job.

8.2.4 Input with fixed value

In the SmartWeb software, you can create inputs with a fixed value, which you can access when creating
measurement jobs. An input with a fixed value can be useful, for example, if the machine to be monitored runs at a
constant speed. In this case, you do not have to connect a sensor; rather you can specify the speed via the fixed
value. In the factory default setting, the SmartCheck or ProLink device has one input with a fixed value, which is
configured as follows:

· Name: fixed speed

· Value: 3000

· Unit: RPM

In the Input configurations area, you can view and edit the details for the fixed values:
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You have the following options:

· Click on Edit  to edit the selected input with a fixed value.

· Click on Delete  to delete the selected input with a fixed value.

· Click on Add  to add another input with a fixed value.

· Click on  to open the configuration overview .

How to add a new input with a fixed value

1. Click on  to open the window Add fixed value:

You have the following options:

Name The input with a fixed value is listed under this name, along with the other inputs.
Therefore, you should choose a practical name that will enable you to distinguish between
the inputs.

Value Here you specify the fixed value.

Unit group Here you specify which unit group the fixed value belongs to, e.g. Torque, Pressure,
Speed or Force.

Unit Here you can specify the unit of measurement for the fixed value. The selection options
correspond to the selected unit group.

2. Click on OK to save your changes. The new input with a fixed value appears in the table:
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3. To Delete  or Edit  the input with a fixed value, select the entry in the table and then choose the
corresponding command.

8.3 Measurement jobs

To enable the Schaeffler SmartCheck or ProLink vibration monitoring system to monitor your machine and trigger
alarms if appropriate, the incoming signals must be measured and characteristic values calculated. The corresponding
instructions are located in what are known as measurement jobs, which you can create using the SmartWeb
software.

The SmartCheck or ProLink device is distinguished by the support the system gives you in the creation of these
measurement jobs and especially in the calculation rules for characteristic values: You create measurement jobs
exclusively with the aid of the Configuration wizard . In the very first step of the wizard, you select a
template  that is suitable for your machine. According to the template you selected, e.g. the Gear stage
template for the monitoring of two gears, the SmartCheck or ProLink device then automatically generates the
appropriate characteristic values. In addition, a superordinate alarm characteristic value is generated for each
measurement job, which summarises the alarm status of all characteristic values.

You cannot edit the characteristic values the SmartCheck or ProLink device generates; you can only view them in
the corresponding overview in the SmartWeb software. However, you specify a series of framework conditions for
the measurement job in the configuration wizard, e.g. triggers or conditions , the dependency of an alarm on
additional signals, or the activation of the learning mode.

Selection of the right template and correct entries in the configuration wizard is a key factor in enabling your system
to perform the monitoring as required. Consequently, the following sections are to support you in these work steps.
You will find here:

· The detailed description of the Measurement jobs  area.

· An overview of the Steps in the configuration wizard  that you follow to create a measurement job. This
section contains a summary of each step and any additional information further to the info texts in the
configuration wizard.

· An Overview of the templates  available to you when creating a measurement job.

· Detailed explanations of the Learning mode  and Alarm maps , two special functionalit ies that the
SmartCheck or ProLink device provides you for monitoring. Both are activated from the configuration wizard.

8.3.1 Measurement jobs area

In the Measurement jobs area, you will find an overview of all measurement jobs you have created for the
SmartCheck or ProLink device. Each measurement job includes the following components:

· Measurement configurations: These determine the inputs at which measurements are made and how these
measurements are performed.

· Characteristic value configurations: These values are calculated automatically from measurement signals
according to internal templates.

· Optional component: Triggers or conditions  can be added to the measurement job in order to control the
execution of measurements.
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You can view and partly edit all of these components and their details in the Measurement jobs area. In the
factory default setting of the SmartCheck device or for each ProLink vibration sensor, the base measurement job
is created:

In the expanded overview on the left, you will find all measurement jobs for the SmartCheck or ProLink device. Click
on a measurement job to access the following information and functions in the main panel:

· Under Measurement jobs, you will see the name of the measurement job as well as any details such as triggers
or conditions used. Here you will also find a yellow box with change details and the Edit, Delete and Create
buttons.

· Under Characteristic value configuration you will see the individual characteristic values that belong to the
selected measurement job. If you click on one of the values, the details about it are displayed on the right. These
details partly correspond to your own settings, which you made when creating the measurement job ; the rest
are added automatically by the wizard from system templates.

· Under Measurement configuration you will see the measurements that belong to this measurement job. If you
click on one of the values, the details about it are displayed on the right. These details partly correspond to your
own settings, which you made when creating the measurement job ; the rest are added automatically by the
wizard from system templates.
Under Characteristic value configuration, the characteristic values that belong to the selected measurement
are also automatically highlighted in bold.

· You can edit the selected measurement job .

· You can add new measurement jobs .

· You can delete the selected measurement job. To do so, click Delete  and confirm with OK.

· In the top right corner, click on  to open the Configuration overview .
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· You can find the menu item Create new measurement job in most work areas of the
SmartWeb software on the left under Actions, which means that you are always able to
access this main system task.

· If a characteristic value of a measurement job is used for the alarm status configuration of
a controller , you cannot edit or delete this measurement job. An exception is an input
with a fixed value.

8.3.2 Creating/editing new measurement jobs

The configuration wizard opens when you want to create or edit a measurement job. This guides you step by step
through the creation process. Here you only need to specify a few details, as the complex calculations of the
characteristic values of a component are executed inside the system using the relevant templates .

To be able to use input signals for the monitoring, you must create the corresponding input
configuration  before you start the wizard.

The configuration wizard consists of several steps, which are displayed in the left margin right from the start. How
many steps you need to go through depends on which component template you choose and whether you activate
the Expert settings:

The wizard queries additional information in the individual steps. Generally, the entries you
need to or can make are already explained in the wizard. Simply move the mouse over the

question mark  to read the explanation.
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In the following sections, you will find a summary of each individual step along with additional information that goes
beyond the basic Help.

Select component
Here you choose the component you want to monitor from the predefined list. The system template  that is
used to create the measurement configuration depends on your selection here.

If you turn on the Expert settings, you can select the Confidential option. This means that the measurement
job remains visible in the user interface and the measurements run as usual. However, the alarm limits and frequency
bands of confidential measurement jobs are only visible for users with special rights . No other users can view or
edit the details of the measurement job. This restriction applies not only to the measurement job area but also to
the display of frequency bands in the live view and measurement data areas.

In some measurement jobs, it is necessary to be able to edit the speed channel. Users
without special rights cannot do this for a confidential measurement job. In such a case,
assign the Edit speed channel  right. Users with this right cannot see the details of the
measurement job, but can edit the speed channel.

Specify details about the component
Here you make detailed specifications about the selected component. Make these specifications depending on the
component, e.g. the maximum speed, the type of installation, or the number of blades or vanes. This is also where
you determine the input signals on which the monitoring is to be based.

If the component is a bearing, you can select the bearing type straight from the system bearing database in this
step. If it is not in the database, you can create it using the wizard.

In this step, all templates - except the Base configuration and the Default
configuration - request a Speed signal and the Maximum speed. For the speed signal, a
characteristic value is automatically created. The alarm limits for this value depend on the
specified Maximum speed. While the other characteristic values created by the wizard are
listed in the last step in an overview, this characteristic value remains in the background.
Consequently, you can neither change its alarm limit nor activate the Learning mode  for
it.

The system default alarm limit, which uses this characteristic value, is calculated as follows:

· Pre-alarm: 1% above the specified maximum speed

· Main alarm: 5% above the specified maximum speed

Apply expert settings/Apply expert settings for the Wellhausen counter
These steps only become visible if you activate the Expert settings option on the bottom left of the wizard.
Furthermore, the step Apply expert settings for the Wellhausen counter is only available for the default
configuration. In both steps, you have the option of adjusting some preset values of the template for your
specific measurement job, e.g. specifying the number of spectral lines or the high-pass for the demodulation.

You should only edit this step if you possess expert knowledge.

The value that you specify for Number of spectral lines affects the length of the recorded
signals. All vibration measurements are based on this value. As such, the duration of the
various measurements may vary. The duration of the longest vibration measurement
determines the measurement duration for all other additional measurements:

Measuring time for vibration time signals [s] = number of lines / low-pass

Additional channels record the number of values required for the longest vibration
measurement up to a maximum of 100,000 values. For an analogue input, for example, this
corresponds to a measuring period of approx. 78 s.

Apply learning mode settings
This step is only visible if you activate the Expert settings option on the bottom left of the wizard. Here you can
specify the algorithm used by the learning mode to calculate the alarm limits and the factors used to determine the
main alarm and pre-alarm.
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If you select the Learning mode type, you should note the following:

· Standard deviation: This process takes into account when signals vary or are not very
stable, i.e. when the value for sigma, the signal variance, is high.

· Maximum values: This selection is preset and is the better method in most cases. You
can select this method when the vibration values are very stable, i.e. when the value for
sigma, the signal variance, is low.

You should only edit this step if you possess expert knowledge.

Save settings/triggers and conditions
Here you specify how often trends and time signals should be saved. In addition, you can determine whether the
measurements should depend on Measurement triggers , Time triggers, Measurement conditions  or Time
conditions.

If you have not yet created any measurement triggers or measurement conditions or the existing ones do not meet
your requirements, you can create them using the wizard. You can only create time triggers and time conditions
within the wizard. You can find information on this in the Triggers and conditions  section.

Additional signals
Here you can add additional input signals to the measurement configuration. This adds further trends to the
characteristic value trends, which are generated automatically by the template.

The automatically created characteristic values of the additional signals can be retrieved in
the characteristic value overview in the last step of the configuration wizard. There you can
also change the alarm limits of these characteristic values.

Typically, it is not necessary to activate the Learning mode  for the additional signals; if
you do want to authorise it, you can do so in the last step of the wizard.

Resetting/setting alarms
In this step, you specify:

· Whether alarms are to be reset automatically or manually, i.e. via the Context menu , for example.

· Whether and for which characteristic values the learning mode should always be authorised.

· Whether the learning mode calculates alarm limits contingent on measured machine parameters (alarm map ).

· Where the limits for the main alarm and pre-alarm lie: You can specify this for all characteristic values together or
for each individual characteristic value.

· For symmetrical signals with a negative value range: where the thresholds for the lower main alarm and pre-alarm
lie; these options are only used for additional signals.

· How the alarms are reset: You can specify this for all characteristic values together or for each individual
characteristic value.
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If you activate the option Change alarm limits in line with other signals, you also must
authorise the learning mode; otherwise, the option has no effect.

You should not use the learning mode when the measurement range is known, e.g. for
temperature, pressure or load.

For characteristic values based on ISO, the limits of machine class II are preset for the alarm
limits. Learning mode is activated by default and can therefore overwrite the alarm limits
based on ISO, if applicable:

Here you have the following options:

· Click on Machine class (ISO 10816). A context menu is displayed, from which you can
select the required alarm limits.

· You can manually set alarm limits that deviate from the ISO recommendations.
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8.3.3 Available templates for measurement configurations

In the first step of the configuration wizard, you need to choose a template that will be used to create the
measurement job for monitoring your machine. The following list gives a rough overview of which template is most
suitable for which machine/monitoring scenario:

· Basic configuration:Use the template for broad-band measurement. It can be used for all machines, but only
offers a very general monitoring.

· User-defined frequency bands: Use this template to define user-defined frequency bands, where a separate
characteristic value is created for each one. You should only use this template if you possess expert knowledge.

· Gear stage (optimized): Use this template for continuous monitoring of two gears. This template is an
improved version of the previous Gear stage template (now Gear stage (obsolete)). In contrast to the
obsolete version, it enables better alarms for the various damage types (distributed damage or local damage). It
also triggers alarms on gears whose sidebands increase in the case of damage, while the gear meshes decrease.

· Gear stage (obsolete): Use this template for the monitoring of two gears. This template is only still available
for use with existing measurements for compatibility reasons. For new gear monitoring tasks, we recommend
that you use the Gear stage (optimized) template.

· Journal bearing: Use this template for the monitoring of a bearing with oil film.

· Channel monitoring: This template lets you continuously monitor up to three channels (similar to the
condition guard), resulting in a faster response to changes.

· Coupling: Use this template for the monitoring of a jaw coupling.

· Fan: Use this template for the monitoring of fan blades.

· Managed frequency bands: Use this template to define managed frequency bands, where a separate
characteristic value is created for each one. Speed-coupled frequency bands are shifted depending on a speed
signal. The frequencies are not entered in Hz, but instead are standardised according to the speed.
You should only use this template if you have the relevant expert knowledge.

Example:
You use the rotational frequency to identify an imbalance. To do this, create a window of 0.95 and 1.05.
At a speed of 50 Hz, the device dynamically adapts the frequency band:
(50 Hz * 0.95 =) 47.5 Hz to (50 Hz * 1.05 =) 52.5 Hz

· Pump: Use this template for the monitoring of pump vanes.

· Belt drive: Use this template for the monitoring of a belt level.

· Default configuration: Use this template for broad-band measurement with several filters. It can be used for
all machines, but only offers a very general monitoring.

· Shaft: Use this template for the monitoring of a shaft.

· Roller bearing: Use this template for the monitoring of a roller bearing.

· Condition guard: Use this special template for the constant monitoring of a machine pursuant to the standard
ISO 10816-1.

Some of the measurement templates listed here can only be used with an additional licence.
For an overview of your current licences, select Open licence manager  from the Help
menu.

8.3.4 Triggers and conditions

The SmartCheck or ProLink device generally works through the measurement jobs in a fixed order. You can use
triggers and conditions to interrupt this order. In the Memory settings/measurement triggers and conditions
step, you can create or edit triggers and conditions:

14
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You can create the following triggers and conditions here:

· Time trigger
· Meas. trigger
· Time condition
· Measurement condition
Relevant details can be found in the following sections.

· You can also create and edit measurement triggers and measurement conditions without
the wizard in the Measurement trigger  and Measurement conditions  areas.
You can then select the triggers and conditions created there from a list in the wizard.

· You cannot use measurement triggers and measurement conditions for output
configurations.

· For each measurement trigger and each measurement condition, a characteristic value is
created. This characteristic value can be found in the overview under the measurement
job Measurement triggers and conditions.
The corresponding characteristic values are also saved only if a trigger or condition is used
by at least one measurement task. When creating the trigger or the condition, determine
the saving interval. In addition, characteristic values are always stored if the status
changes, for example, if the condition changes from valid to invalid or a trigger is initiated.
You can use the trends for these characteristic values to check whether measurement
triggers and measurement conditions on the real machine behave as you expect. You can
therefore check whether a measurement trigger is also actually triggered, or whether a
measurement condition is correctly enabled or disabled.

The diagram below provides an overview of the interaction and prioritisation of conditions and triggers:
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Under the following circumstances, a measurement initiated by triggers is not started:

· If the conditions are not fulfilled at the time of the trigger.

· A measurement initiated by a trigger is already running.

8.3.4.1 Time trigger

A time trigger allows you to specify that the measurement will take place regularly at an interval defined by you,
e.g. every 5 minutes. You can only create one time trigger for each measurement job.

How to create a time trigger

1. Click the  Time trigger button.

2. Enter the desired specifications under Time trigger:
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You have the following options:

Measurement interval:
every

Use this specification to determine the measurement interval, i.e. the time after
which the measurement is to be repeated. You can specify an interval in Minutes,
Hours or Days.

Start of measuring Here you specify the day and time when the measurements are to start. Here you
have the following options:

· You can either select the start date from the list boxes or set it directly via the

calendar .

· Enter the start time in the field next to HH:MM.

Click Delete  to remove this time trigger.

Move the mouse over the question mark  to read additional information.

Time triggers ignore the shift that results from the change from summer to winter time.

Example:

· In winter, you create a time trigger with Start of measuring 14:00. In summer, the
start of measuring will not be until 15:00.

· In summer, you create a time trigger with Start of measuring 14:00. In winter, the
start of measuring will be at 13:00.

8.3.4.2 Measurement trigger

You can use a measurement trigger to interrupt the order of measurements. If the trigger condition you have
defined is fulfilled, the current measurement is cancelled and the measurement controlled by the measurement
trigger is started.

How to create a measurement trigger

1. Click the  Measurement trigger button.

2. Enter the desired specifications under Measurement trigger:
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You have the following
options:

Measurement trigger
(list box)

This list contains the measurement triggers that you have previously created in the
Measurement trigger  area. Select the required measurement trigger from
here.

If you cannot find a suitable measurement trigger in the list box, click  to create
a new measurement trigger. The Add measurement trigger dialogue opens and
you can enter the desired specifications here. You can find details on this in the
Adding/editing measurement trigger  section.

Click Delete  to remove this measurement trigger.

Move the mouse over the question mark  to read additional information.

8.3.4.3 Time condition

You can use a time condition to ensure that measurements are only performed at a certain time.

How to create a time condition

1. Click the  Time condition button.

2. Enter the desired specifications under Time condition:
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You have the following options:

Mon.-Sun. Activate here the days on which measurements are to start.

From ... To ... Enter here the times between which the measurements are to take place.

The time range that you specify here can also run from one day into the next.

Example: You have activated Mon and Tues and enter the following as the time range:
From: 17:00 To: 8:00
The time range for measurements then begins on Monday at 17:00 and ends Tuesday morning
at 8:00. After a break, measurements will resume at Tuesday 17:00 and continue until
Wednesday at 8:00.

Click Delete  to remove this time condition.

Move the mouse over the question mark  to read additional information.

· If multiple time conditions are defined for a single measurement job, only one condition
needs to be met for the measurement to be performed.

· Time conditions ignore the shift that results from the change from summer to winter time.
Example:

o In winter, you create a time condition for the period from 14:00 to 16:00. In
summer, the time period shifts to 15:00 to 17:00.

o In summer, you create a time condition for the period from 14:00 to 16:00. In
winter, the time period shifts to 13:00 to 15:00.
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8.3.4.4 Measurement condition

In a similar way to the time condition, the condition you define here must be met in order for a pending
measurement to take place. If a measurement is pending but the measurement condition you defined is not met,
the device skips this measurement and goes straight to the next one.

How to create a measurement condition

1. Click the  Measurement condition button.

2. Enter the desired specifications under Measurement condition:

You have the following options:

Measurement condition
(list box)

This list contains the measurement conditions that you have previously created in
the Measurement conditions  area. The Machine is running measurement
condition is preselected. This is preconfigured on the device. The measurement
condition can be deleted on a ProLink device but not on a SmartCheck or ProLink
device.

Select the required measurement condition from here.

If you cannot find a suitable measurement condition in the list box, click  to
create a new measurement condition. The Add measurement condition
dialogue opens and you can enter the desired specifications here. You can find
details on this in the Adding/editing measurement conditions  section.

Click Delete  to remove this measurement condition.

Move the mouse over the question mark  to read additional information.

If multiple measurement conditions are defined for a single measurement job, all conditions
must be met for the measurement to be performed.

8.3.5 Learning mode and alarm maps

When you create a measurement job, the relevant characteristic values are automatically generated. The default
alarm limits of the SmartCheck or ProLink device initially apply to these characteristic values. If you activate the
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learning mode in the Set alarms step of the configuration wizard and then start learning mode, the SmartCheck or
ProLink device starts to evaluate the measurement values of the relevant characteristic values for alarm limits, which
are adapted to your machine. When the learning mode is completed, the default alarm limits are replaced by the
newly calculated alarm limits.

Essentially, the learning mode can be run in two different scenarios, in the simple Default setting  or with an
Alarm map , i.e. dependent on one or two other signals (machine parameters). These scenarios are described in
detail in the following sections. In further sections, you will be given important information on using the learning
mode  and how to proceed during the initial setup  of the SmartCheck or ProLink device.

Scenario 1: Learning mode in default setting
When you create a measurement job - in this example, the pre-configured Base configuration - the learning mode
is already activated in the Set alarms step for all vibration characteristic values:

When you complete the wizard with OK, you can then start learning mode for all characteristic values for which the
learning mode was activated. You have the following options:

· Press the TEACH key on the SmartCheck or ProLink device to start learning mode for all characteristic values for
which the learning mode was activated.

· In the SmartWeb software, open the context menu for a characteristic value. Use the Start learning mode
command to start learning mode for the selected characteristic value.

· In the SmartWeb software, open the context menu for a measurement job. Use the Start learning mode for
all command to start learning mode for all characteristic values for the selected measurement job.

The learning process then looks like this:

· The Schaeffler SmartCheck or ProLink device records 1000 measurement values; here each measurement
performed is saved in the trend - independently of the memory cycle of the trend that you specified in the Save
settings/triggers and conditions step. The speed of this process can depend on your triggers and
conditions .
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· The default of 1000 measurement values can be changed in the configuration wizard. To
do so, activate the Expert settings option. The Apply learning mode settings step
appears, in which you can change the number of values.

· Learning mode is deactivated by default for characteristic values ISO10816-1 (2 Hz to 1
kHz) - velocity and ISO10816-1 (10 Hz to 1 kHz) - velocity.

· As soon as the SmartCheck or ProLink device has saved 1000 measurement values in the trend, a new alarm limit
for the relevant characteristic value is calculated on this basis; here the SmartCheck or ProLink device uses the
Maximum values as an algorithm. In the Apply learning mode settings  step of the wizard, you can
change/adapt this procedure.

· When the learning mode for a characteristic value is completed, a corresponding message appears in the
logbook , which also contains the newly calculated alarm limits. You can view the alarm limits in the trend in the
Measurement data  area as well.

· Once learning is complete, learning mode for this characteristic value is automatically deactivated in the
measurement job. If you wish to restart learning mode at a later point, you must tick the appropriate box again in
order to activate. You can do this in either the configuration wizard  or the Edit alarm settings  dialogue.

· During this process, the learning mode only determines main and pre-alarm limits. The value you specified for
Signal always larger than in the Set alarms step is automatically adjusted if the new alarm limits overlap.

Scenario 2: Learning mode and alarm map
Alarm maps are used in connection with the learning mode if your machine is operated in different operating states
each having its own alarm limits. In this case, you can run the learning mode dependent on one or two further
signals (machine parameters). To do this, the SmartCheck or ProLink device must be able to measure the
corresponding signals via the analogue or digital input. The following example shows which specifications you must
make additionally in the configuration wizard:

Your machine, which is operated at different speeds, has a speed range of between 2000 rpm and 3000 rpm. In
order to calculate alarm limits contingent on this speed range with the learning mode, make the following entries in
the Set alarms step of the configuration wizard:

· Activate the Change alarm limits in line with other signals option.

· For the input, select the speed input – in this example the digital input.

· For Min [RPM], specify the value 2000.

· For Max [RPM], specify the value 3000.
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· Activate the learning mode for the corresponding characteristic values.

As soon as you complete the wizard with OK, you can start learning mode in the same way as with the Default
setting ; learning process deviations from the default setting are as follows:

· The reference speed range of 2000 to 3000 is broken down into an alarm map with 10 fixed alarm fields:

· For each of these alarm fields, the SmartCheck or ProLink device takes in 1000 measurement values in order to
calculate from them an alarm limit of its own for the corresponding alarm field.

· For as long as an alarm field does not yet have a new alarm limit, the default alarm limit applies for the field.

· Each alarm field is processed  individually, which means it is possible for the learning mode to be completed in
one alarm field already, while the default alarm limits still apply in the other alarm fields.

· When the learning mode for an alarm field is completed, a corresponding message appears in the logbook ,
which also contains the newly calculated alarm limits.

· While the learning mode is running, the status LED of the SmartCheck or ProLink device flashes. When running
through the alarm fields in an alarm map, the LED may stop flashing briefly because the device has reached a field
that is already completed. However, it will start flashing again as soon as it reaches a field for which the learning
mode is not completed.

You can also use the learning mode contingent on two machine parameters. In this case, you must specify a second
signal in the Set alarms step of the configuration wizard:
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As soon as you complete the wizard with OK, you can start the learning mode process as described above.
However, the alarm map is significantly expanded, as a matrix with 100 alarm fields is now generated, with an alarm
limit calculated for each field.
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· The SmartCheck or ProLink device creates the characteristic value for the machine
parameter(s) in the background; you cannot change their alarm limits manually: they
depend on your entry for the value range.

· If a measured value lies outside the value range you have specified, the SmartCheck or
ProLink device uses the alarm limit of the nearest alarm field.

· After a firmware update, the checkbox for Use learning mode is activated for all alarm
maps – regardless of whether or not the learning mode has already been completed for
this map. Learning mode is not activated after the update, the control maps therefore
initially remain unchanged. As soon as you activate learning mode, all control maps are
learned again. In this process, they lose all previously learned values. To prevent this,
proceed as follows:
In the SmartWeb software, set learning mode for each individual field by selecting one or
more fields and deactivating/activating the checkbox for Use learning mode.

General information on the learning mode
In this section, you will find useful pointers on working with the learning mode.

When is it useful/possible to use the learning mode, and when not?
· For the learning mode, the machine must be in good condition, i.e. not damaged in any way. For monitoring

vibrations in accordance with ISO 10816-1, an additional requirement is that the machine vibrations should lie
within the range of the ISO characteristic value. This is true of machines "that are normally considered acceptable
for long-term operation" (ISO definition for the good condition of a machine).

· The learning mode can only determine optimal values if the machine is in its normal state/operation. You should
not start the learning mode if your machine is currently idle or being started or stopped.

If you are not sure how to find out the normal operating state of your machine, ask your
customer support representative.

· In general, it makes sense to use the learning mode in connection with vibration signals.

· You should not use the learning mode when the measurement range is known, e.g. for temperature, pressure or
load.

· For additional signals, which you specify in the Additional signals step (configuration wizard), the learning mode
is generally not necessary.

No alarm is output during the learning phase. An alarm is output only if learning mode is
complete and the machine exhibits high vibrations. The status LED of your SmartCheck or
ProLink device then lights up permanently in yellow or red. This could be an indication of
excessive vibrations. In this case, inspect the machine and the settings in the SmartWeb
software. If necessary, contact a vibration expert or your customer support representative
(see Support).

How do changes to the system affect the learning mode?
· In changing the value range of the signal that is used for the alarm map in the Set alarms step (configuration

wizard), you also change the dimension of the alarm map. Therefore, upon completion of the wizard, all alarm
limits that the learning mode has determined up to that point are discarded. As for a newly created measurement
job, the default alarm limits are now in all alarm fields again.

· When you work with the learning mode, the SmartCheck or ProLink device takes over the default alarm limits of
the characteristic values at the start of the process. As soon as the learning mode has been completed once, the
system will then only use the new alarm limits. If you change the default alarm limits of the characteristic value,
the changes take effect immediately on the system. As such, you can also adjust the alarm limits during the
learning phase.

· If you switch off the SmartCheck or ProLink device, the learning mode will only be interrupted; the measurement
results to date are not lost.
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If you turn off the machine while the learning mode is active, the learning mode will be
executed on an idle machine, which will result in incorrect measurement values and thus
incorrectly calculated alarm limits too. You should therefore restart the learning mode when
the machine is running again.

When should the learning mode be restarted and what happens then?
· You should always restart the learning mode when the machine parameters or the vibration behaviour have

changed. This is likely in the following cases, for example:

§ After repairs

§ After structural changes to the machine

§ After changes of mechanical parameters.

· If the learning mode was already completed, the previous alarm limits will be retained after a restart until the
calculation of the new alarm limits is finished.

· If the learning mode was not yet completed and is restarted, the values already measured will be discarded and all
set values will need to be measured again.

How is the learning mode activated/started?
Activation
· Schaeffler SmartWeb: Via the Create new measurement job or Edit measurement job wizard in the Set

alarms step, or via the Alarm settings button under Characteristic value configuration 

Start/Restart
· Schaeffler SmartWeb: Via the context menu for measurement configurations and characteristic values, e.g. in the

Status area.

· Schaeffler SmartCheck or ProLink: via the TEACH key. This starts the learning mode for all characteristic values of
your system for which the learning mode is authorised.

Procedure for initial set-up
For the initial set-up of the Schaeffler SmartCheck or ProLink device, proceed as follows:

1. Install the SmartCheck or ProLink device and set up the connections. Details on this can be found in the
Schaeffler SmartCheck or ProLink user documentation.

2. Create the desired configuration with the SmartWeb software. You can find an initial overview of the necessary
steps on the start page of the Configuration  area.

3. Only start the learning mode once your machine is in a defined normal state, i.e. temperature, pressure etc.
have reached normal values. Measurements outside the normal state can negatively affect the measurement
result.

8.4 Output configurations

Depending on the system, you have the following options:

· Schaeffler SmartCheck device: For the Schaeffler SmartCheck device, you can configure  a total of two
outputs, one analogue output and one digital output. In the Output configurations area, you will find an
overview of all outputs of the SmartCheck device currently configured. In the factory default setting of the
SmartCheck device, the analogue output is configured as Overall alarm status

· Schaeffler ProLink device: Once you have started the Schaeffler ProLink device, the outputs for the
connected vibration modules  are automatically created and assigned to the modules. Four digital outputs are
possible per vibration module. You can also create up to eight analogue or digital outputs for the connected I/O
modules via the module configuration . In the Output configurations area, you will find an overview of all
outputs and you can also configure them here.
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In the expanded overview on the left, you will find all output configurations for the SmartCheck or ProLink device.
Click on an output configuration to access the following information and functions in the main panel:

· The Name and the details on the selected output configuration are displayed on the left.

· On the right, in the field highlighted in grey, you will find details on the creation and changing of the output
configuration.

· You can edit the output configuration .

· You can add a new output configuration . The maximum number possible is one digital and one analogue
output configuration for the SmartCheck device or four digital output configurations for each ProLink vibration
sensor.

· You can delete the selected output configuration. To do so, click Delete  and confirm with OK.

For the I/O module of the ProLink device you must use the module configuration  to add
or delete outputs.

· You can test the selected output configuration .To do this, click on  and define the type of test.
The display above the button indicates whether a test is currently active.

· In the top right corner, click on  to open the Configuration overview .

If you reconfigure the outputs on the SmartCheck or ProLink device, you have the following basic options:

Digital alarm limit
You can use the digital output, a pure switching output, as a two-stage alarm limit for any characteristic value
configuration or for the overall alarm status. It can output whether an alarm exists or not, whereby you can
determine whether it should switch as soon as the pre-alarm is triggered or only when the main alarm is reached.
For this output to occur, the output must be connected to your controller.

Analogue alarm output  (SmartCheck and Schaeffler ProLink I/O module)
You can use the analogue output as a three-stage alarm output for any characteristic value configuration or for the
overall alarm status. It can output whether a pre-alarm, a main alarm or no alarm exists. For this output to occur, the
output must be connected to your controller.

Analogue characteristic value output  (SmartCheck and Schaeffler ProLink I/O module)
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You can also use the analogue output to output the characteristic value for any characteristic value configuration or
for the overall alarm status. The selected characteristic value, e.g. temperature, is given to the output as a voltage
signal proportional to the size of the characteristic value and passed on to your controller, where the value can be
interpreted.

· You cannot use triggers or measurement conditions for an output configuration

· Exact information on how to connect the outputs of the SmartCheck or ProLink device
with your controller can be found in the Schaeffler SmartCheck or ProLink user
documentation.

8.4.1 Adding/editing output configurations

You can configure the following outputs on the SmartCheck or ProLink device:

· Analogue characteristic value output  (SmartCheck and Schaeffler ProLink I/O module)

· Analogue alarm output  (SmartCheck and Schaeffler ProLink I/O module)

· Digital alarm output

You can edit  existing output configurations at any time.

For the I/O module of the ProLink device, you must use the module configuration  to add
outputs. To configure the added outputs for your system, select the output in the

expanded overview and click Edit under Output configurations . For information on
the configuration options, refer to the following sections on the analogue characteristic value
output , the analogue alarm output  and the digital alarm output .

How to create an analogue characteristic value output (SmartCheck and Schaeffler ProLink I/O module)

1. Under Output configurations click on Add  (SmartCheck only).

2. Set the required specifications in the Add output configuration window:
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You have the following options:

Name Here, enter the name under which the output configuration is to appear in the
overview.

Output channel From here, select the Analogue output option.

Characteristic value
configuration

In this list, you can find the overall alarm status, all measurement jobs and the
corresponding individual characteristic values of your system. For the analogue
characteristic value output, you must select an individual characteristic value.

You can only select measurement jobs and overall alarm status for one alarm
output.

Output type Here, select the Characteristic value output option.

Current/voltage output Here, determine the range of the voltage or current that is to apply for the
analogue characteristic value output. SmartCheck or ProLink supports the
following ranges:

· 0-10 V

· 0-20 mA

· 4-20 mA

Scaling factor, Min, Max Use these settings to determine the range within which the characteristic
value should lie. First enter a minimum value Min. Then enter a maximum value
Max or define the factor with which the outgoing signal should be scaled in
the Scaling field. Both the diagram and the values of the respective other field
are then adjusted automatically.

If the output value exceeds the maximum value Max, then the maximum
voltage is output.

3. Click on OK to save the new output configuration.

To create an analogue alarm output (SmartCheck and Schaeffler ProLink I/O module)

1. In the Actions area, click on Add  (SmartCheck only).

2. Set the required specifications in the Add output configuration window:
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You have the following options:

Name Here, enter the name under which the output configuration is to appear in the
overview.

Output channel From here, select the Analogue output option.

Characteristic value
configuration

In this list you will find the overall alarm status and the individual characteristic
values of all measurement jobs of your system. You can choose whether the
alarm should be output for the entire system or for an individual characteristic
value.

Output type From here, select the Alarm output option.

Current/voltage output Here, determine the range of the voltage or current that should apply for the
analogue alarm output. SmartCheck or ProLink supports the following ranges:

· 0-10 V

· 0-20 mA

· 4-20 mA

Alarm limit From here, you determine whether the alarm output is to output the pre-
alarm, the main alarm or the pre and main alarms. Below the drop-down
list, you can find information on how current/voltage are distributed to the
alarm statuses.

3. Click on OK to save the new output configuration.
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The analogue outputs of the I/O module are configured as standard in such a way that you
can connect and operate a Schaeffler SmartLampwithout any further settings:

The SmartLamp visualises the ProLink alarm status. Refer to the user documentation for
further details SmartLamp.

How to create a digital alarm output

1. Under Actions, click on Add .

2. Set the required specifications in the Add output configuration window:

You have the following options:
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Name Here, enter the name under which the output configuration is to appear in the
overview.

Output channel · SmartCheck: Here, select the Digital output option.

· ProLink: The Digital output is preset and cannot be changed.

Characteristic value
configuration

In this list, you can find the overall alarm status, all measurement jobs and the
corresponding individual characteristic values of your system. You can choose
whether the alarm should be output for the entire system, a measurement job
or an individual characteristic value.

Output type This is where the Alarm output option is specified.

Alarm limit From here, you determine whether the alarm output is to output the pre-
alarm, the main alarm or the pre and main alarms. In the list box, you can
find information on how the output reacts to the alarm statuses.

3. Click on OK to save the new output configuration.

How to edit an output configuration
1. Select Output configuration in the expanded overview on the left.

2. Under Output configurations, click on Edit  and set the required specifications in the Edit output
configuration window.
For your SmartCheck device, you can also change an analogue alarm output to a characteristic value output and
vice versa here, among other possibilit ies.

3. Click on OK to accept your changes.

8.4.2 Test output configuration

You have the option of activating a test for your output configuration and thus verifying whether your output
configuration is working correctly. You can then determine whether the cabling and the connection to a controller
or display are correct. If a test is already active, it is cancelled as soon as another alarm output is tested.

In the following sections, you will find details on how to test your configured alarm output . You can also test
your configured characteristic value output  for your SmartCheck device.

How to test a configured alarm output

1. Under Output configurations, click .

2. In the Test output configuration window, enter the desired specifications:

You have the following options:

Test duration This is where you define the test duration.

Tested alarm type Here you can select what the test is to simulate:

· No alarm: the test simulates a status without an alarm.

· Pre-alarm: the test simulates a pre-alarm.

· Main alarm: the test simulates a main alarm.

3. Click OK to confirm your settings and start the test. You will then be informed that the test is active and told
what is being tested. This appears as follows for the SmartCheck device, for example:
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4. To cancel the test, click  again.

How to test a configured characteristic value output (SmartCheck only)

1. Under Output configurations, click .

2. In the Test output configuration window, enter the desired specifications:

You have the following options:

Test duration This is where you define the test duration.

Voltage Here, enter the value for voltage or current that is to be tested.

3. Click OK to confirm your settings and start the test. You will then be informed that the test is active and
informed on what is being tested:
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4. To cancel the test, click  again.

8.5 Measurement trigger

The SmartCheck or ProLink device generally works through the measurement jobs in a fixed order. However, you
can interrupt this order using a measurement trigger. As soon as the trigger condition is fulfilled, the measurement
controlled by the measurement trigger is started (after completion of the current measurement).

In the Measurement trigger area, you will find an overview of all measurement triggers. In the factory default
setting, no measurement trigger is configured for the SmartCheck or ProLink device. As soon as you have defined
your own measurement triggers, they are available to you when creating measurement jobs .

In the expanded overview on the left, you will find all measurement triggers of the SmartCheck or ProLink device.
Click on a measurement trigger to access the following information and functions in the main panel:

· The Name and the details on the selected measurement trigger are displayed on the left.

· The entry for Input channel is a link that takes you straight to the corresponding input configuration.

· The entry for Measurement job is a link that takes you straight to the overview of the measurement job in
which this measurement trigger is used.

· On the right, in the field highlighted in yellow, you will find details on creating and changing the measurement
trigger.

· You can edit the measurement trigger .

· You can add a new measurement trigger .

· You can delete the selected measurement trigger. To do so, click Delete  and confirm with OK.
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· In the top right corner, click on  to open the Configuration overview .

· When the condition for a measurement trigger is met, the measurement is started
immediately, even if this means that an ongoing measurement is interrupted.
Measurements that themselves have been started by a measurement trigger are not
interrupted.

· If a measurement trigger is used in multiple measurement jobs, these jobs are executed
sequentially when the trigger condition is met.

8.5.1 Adding/editing measurement trigger

You can add  as many measurement triggers and edit  as many existing measurement triggers as you like on
the SmartCheck or ProLink device.

How to create a measurement trigger

1. Under Measurement trigger, click on Add .

2. In the Add measurement trigger window, make the desired specifications:

You have the following options:

Name Here, enter the name under which the measurement trigger is to appear in the
overview. This name will also appear in the corresponding list box if you want to use
the measurement trigger in a measurement job.

Input channel Here, select the input whose signal you want to use for the measurement trigger.
You will find in the list box all inputs and scaling factors  of your system.

Unit This value is automatically filled for the input channel you have selected.

Calculation type This is where you select the characteristic value most suitable for your signal. The
Offset option is available for many application types.

Threshold Specify here the value from which the measurement trigger should take effect: If
the threshold value is exceeded or fallen below–according to the Edge–the
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SmartCheck or ProLink device interrupts the current measurement and starts the
measurement linked to the measurement trigger.

Measurement values A trigger calculates its current value using the last measured number of values;
enter this number here. This value is therefore used to define the number of
measurement values that the calculation type configured above should calculate,
and the time range over which this value is calculated. You therefore influence the
speed at which a trigger reacts to changes in the input signal and the sensitivity of
the trigger's reaction to signal disruptions:

· A smaller number causes a faster reaction.

· A larger number makes the trigger less sensitive to disruptions.

Example: The sample rate is 1280 values/second (e.g. for an analogue input) and you set
Measurement values to 1280. If you have selected Offset as the calculation type, the
calculated value corresponds to the average over one second via the input channel.

Edge Determine here whether the threshold has to be exceeded or fallen below for
the measurement trigger to take effect:

Falling: The measurement trigger takes effect when the threshold is fallen below.

Rising: the measurement trigger takes effect when the threshold is exceeded.

Lead time Here you define the time prior to initiation of the trigger at which you want the
trends to start recording. This enables you to analyse why the trigger has been
initiated.

Save interval Determine here whether you wish to store values regularly in order to monitor the
measurement trigger. If values are stored regularly, you can view the trend of the
measurement trigger in the Measurement data area and verify, for example, that
the device is actually taking measurements.

You have the following options:

· Never: Select this option if no values are to be stored for a trend.

· n minutes/hours/days: Enter here the frequency at which values are to be
stored for the trend in minutes, hours or days.

A status change - i.e. the execution of the trigger - is always stored, regardless of
the setting selected here.

3. Click on OK to save the new measurement trigger.

How to edit a measurement trigger
1. Select the measurement trigger in the expanded overview on the left.

2. Click on Edit  and make the desired specifications in the Edit measurement trigger window.

3. Click on OK to accept your changes.

You can determine the number of Measurement values according to the following rough
guidelines:

· A small number of measurement values allows the trigger to switch more quickly.

· A small number of measurement values reacts sensitively to short pulses.

· A large number of measurement values is preferable for restless, inconstant signals.

SmartCheck device:
The save interval determines how frequently the trend values of the measurement trigger
are saved. However, if the trigger relates to an analogue input in 4–20 mA mode, the
following restriction applies:

If the value at the analogue input falls below 4 mA, this channel becomes invalid. The values
of the trigger are then no longer measured or saved until the channel is valid again (i.e. the
value at the input rises above 4 mA). This period is displayed with a grey background in the
trend.
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8.6 Measurement conditions

Usually the Schaeffler SmartCheck or ProLink device executes the measurement tasks in a fixed sequence. Using a
measurement condition, you can ensure that measurements are skipped: if a measurement is pending but the
measurement condition you defined is not met, the device skips this measurement and goes straight to the next
one.

If a measurement is pending and the measurement condition is met, the measurement is performed. However,
even during a measurement, the system continually monitors whether the measurement condition is still being met.
As soon as the measurement condition is no longer being met, the measurement is cancelled.

An hour meter  is automatically created for each measurement condition. This indicates the active operating
time of a measurement condition and thus the time of the machine or component. You can see the hour meter in
the Measurement data below the associated measurement condition. There you can edit the hour meter and
view the trend of the hour meter.

In the Measurement conditions area, you will find an overview of all measurement conditions. In the factory
default setting for the SmartCheck or ProLink device, the Machine is running  measurement condition is
preconfigured.

As soon as you have defined your own measurement conditions, they will be available to you when creating
measurement jobs .

In the expanded overview on the left, you will find all measurement conditions for the SmartCheck or ProLink
device. Click on a measurement condition to access the following information and functions in the main panel:

· The Name and the details on the selected measurement condition are displayed on the left.

· The entry for Input channel is a link that takes you straight to the corresponding input configuration.

· The entry for Measurement job is a link that takes you straight to the overview of the measurement job in
which this measurement condition is used.

· On the right, in the field highlighted in yellow, you will find details on creating and changing the measurement
condition.

· You can edit the measurement condition .

· You can add a new measurement condition .

· You can delete the selected measurement condition. To do so, click Delete  and confirm with OK.

· In the top right corner, click on  to open the Configuration overview .
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The preconfigured Machine is running measurement condition is set in the base
measurement job and ensures that the measuring job is only executed when the relevant
machine is actually running. You cannot delete this measurement condition. You can rename
this measurement condition (ProLink only).

However, you should adjust this measurement condition on your machine immediately after
initial operation of the Schaeffler SmartCheck or ProLink device: In the factory default
setting, the fulfilment of the Machine is running measurement condition is based on
vibration signals. Edit the measurement condition  so that it meets the requirements of
your machine. For example, the engine speed is usually a better criterion for determining
whether the machine is running.

The Machine is running measurement condition is usually added to each newly created
configuration by default. However, you can also delete it manually (SmartCheck only).

8.6.1 Adding/editing measurement conditions

On your SmartCheck or ProLink device, you can add  as many measurement conditions and edit  as many
existing measurement conditions as you like.

How to create a measurement condition

1. Under Measurement conditions, click on Add .

2. In the Add measurement condition window, make the desired specifications:

You have the following options:

Name Here, enter the name under which the measurement condition is to appear in
the overview. This name will also appear in the corresponding list box, if you
want to use the measurement condition in a measurement job.

Input channel Here, select the input channel whose signal you want to use for the
measurement condition. You will find in the list box all inputs and scaling
factors  of your system.

Unit This value is automatically filled for the input channel you have selected.

Calculation type This is where you select the characteristic value most suitable for your signal.
The Offset option is available for many application types.
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Measurement values A condition calculates its current value using the last measured number of
values; enter this number here. This value is therefore used to define the
number of measurement values that the calculation type configured above
should calculate, and the time range over which this value is calculated. You
therefore influence the speed at which a condition reacts to changes in the
input signal and the sensitivity of the condition's reaction to signal disruptions:

· A smaller number causes a faster reaction.

· A larger number makes the condition less sensitive to disruptions.

Example: The sample rate is 1280 values/second (e.g. for an analogue input) and you
set Measurement values to 1280. If you have selected Offset as the calculation
type, the calculated value corresponds to the average over one second via the input
channel.

Lower threshold / 
Upper threshold

With these two thresholds, you determine the range within which the
measurement condition counts as met; the measurement associated with this
condition is then performed.

In our example, this range is between 40 and 60°C; with a value of e.g. 65°C,
the measurement condition would not be met and the measurement would be
skipped or cancelled.

Save interval Determine here whether you wish to store values regularly in order to monitor
the measurement condition. If values are stored regularly, you can view the
trend of the measurement condition in the Measurement data area and
verify, for example, that the device is actually taking measurements.

You have the following options:

· Never: Select this option if no values are to be stored for a trend.

· n minutes/hours/days: Enter the frequency at which values are to be
stored for the trend in minutes, hours or days here.

A status change - i.e. the fulfilment of the condition - is always stored,
regardless of the setting selected here.

3. Click on OK to save the new measurement condition.

How to edit a measurement condition
1. Select the measurement condition in the expanded overview on the left

2. Click on Edit  and enter the desired specifications in the Edit measurement condition window.

3. Click on OK to accept your changes.

You can determine the number of Measurement values according to the following rough
guidelines:

· A small number of measurement values allows the measurement condition to switch more
quickly.

· A small number of measurement values reacts sensitively to short pulses.

· A large number of measurement values is preferable for restless, inconstant signals.

SmartCheck device:
The Save interval determines how frequently the trend values of the measurement
condition are saved. However, if the measurement condition refers to an analogue input in
4–20 mA mode, the following restriction applies:

If the value at the analogue input falls below 4 mA, this channel becomes invalid. The values
of the measurement condition are then no longer measured or saved until the channel is
valid again (i.e. the value at the input rises above 4 mA). This period is displayed with a grey
background in the trend.

8.7 Communication channels

In the Communication channels area, the expanded overview on the left shows the communication channels
that you have created for the SmartCheck or ProLink device. You can create the following communication channels:
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· An  e-mail communication channel , to send e-mails with data attachments from the SmartCheck or
ProLink device.

· Multiple channels for  controllers , to integrate these into the monitoring with the SmartCheck or ProLink
device and to provide you with data from the SmartCheck or ProLink device.

· An  OPC UA server communication channel  to set up the SmartCheck or ProLink device as an OPC UA
server.

· A PROFINET communication channel  to connect the ProLink device to your controller via the PROFINET
module.

· A Schaeffler Cloud communications channel , to exchange data with the Schaeffler Cloud.

In the right-hand main panel, you will find basic details about the currently selected communication channel as well
as information on its inputs and outputs, if these can be created or have been created:

Click on a communication channel in the main panel to access the information and functions relating to the
respective channel. Information and functions are different for each type of communication channel. Relevant details
can be found in the following sections.

8.7.1 Communication channel for email

In the  communication channel (e-mail)  area, you can extend the possibilit ies of condition monitoring using
the SmartCheck or ProLink device, by creating an e-mail communication channel and sending e-mails via the
SmartCheck or ProLink device. Emails from the SmartCheck or ProLink device are sent to any receiver group via the
SMTP server defined by you. You can include characteristic values and time signals of the selected
measurement tasks as attachments, and the sending of emails is controlled according to timing or alarms.

In order to use the email function, the following steps are necessary:

· First, create the email communication channel . Enter the settings for connection to the email server.

· Next, create one or more outputs for the email communication channel . You can define the structure,
content and triggers of the emails.
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· After you have created everything, you will find an overview of the email communication channel and its outputs
in the communication channel (email)  area.

8.7.1.1 Communication channel for email area

In the Communication channels area, the expanded overview on the left shows the email communication
channel that you have created for the SmartCheck or ProLink device. On the right of the main panel, you will find
basic details about the selected email communication channel, as well as information about its outputs:

Click on an email communication channel to access the following information and functions in the main panel:

Communication channels
Here you can find the basic information and functions for the selected email communication channel:

· Alongside the name you will find details of the SMTP server with which the emails should be sent.
You can also see the details of the proxy server used, if one is configured.

· : If you select the email communication channel, this symbol is updated to show whether email
communication is working or not:
Green symbol: Indicates problem-free communication.
Red symbol: Indicates a problem with the communication. In this case you will see an error
message  if you hover the mouse over the symbol.

To update the symbol again, click on .

· Click on  to test the email communication channel.

· Click on Add  to add an email communication channel. For more details, please refer to
Adding/editing an email communication channel .

· Click on Edit  to edit the email communication channel. For more details, please refer to
Adding/editing an email communication channel .

· You can also delete the email communication channel. To do so, click Delete  and confirm with OK.

· In the top right corner, click on  to open the Configuration overview .

106

114

107

110

56



107

Configuration

The SmartCheck or ProLink device supports a maximum of one email communication channel.

If you have already configured an email communication channel, the Add button  now
only enables you to add controllers .

Outputs for communication channel: email
With an email output, you define when and how the email is triggered, the recipient(s) of the email, the
text of the email, and which data is included in the attachment.

If you have already created outputs for the email communication channel, the Outputs for
communication channel area contains the following information:

· The table below shows the most important details of the email output. These include the name of the
email, its recipients, the subject, and information about the attachment (data type, alarm) and the
triggers (start time, repetitions).

· Click  at the beginning of the line to display the attachments that are defined for the selected email
output.

· Click on Edit  to edit the selected output using the wizard. More details are available in
Creating/editing outputs for an email communication channel .

· Click on Create  to create a new output with the assistance of the wizard. More details are available
in Creating/editing outputs for an email communication channel .

· You can also delete the outputs. To do so, click Delete  and confirm with OK.

8.7.1.2 Adding/editing an email communication channel

To enable the emails to be sent via the SmartCheck or ProLink device, you must create an email communication
channel and tell the SmartCheck or ProLink device the details of the SMTP server to use for sending emails and, if
applicable, the details of the proxy server used.

How to create an email communication channel

1. Under Communication channels, click on Add to open the wizard. This guides you through the creation of
the email communication channel in three steps.

2. In the first step, select the email communication channel type.

The SmartCheck or ProLink device supports a maximum of one email communication channel.
If you have already configured an email communication channel, you can only select
controllers  here.

3. In the second step, enter the necessary information about the SMTP server used to send the emails:
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You have the following options:

Server name Enter the name of the SMTP server:

· Full network name of the SMTP server, e.g. smtp.company.com
or

· IP address of the SMTP server

You can enter both internal as well as external SMTP servers.

Server port and encryption
protocol

Enter the port and encryption protocol of the SMTP server.

The server port automatically adjusts to the default port for the respective
encryption protocol:

· 25 for encryption protocol None
· 587 for encryption protocol StartTLS
· 465 for encryption protocol SSL
You can manually change the server port. If you change the encryption
protocol following a manual change of the server port, the server port no
longer switches automatically to the default port.

Email sender address Enter the email address that you want to appear as the sender of the
SmartCheck or ProLink email. Replies to the email will be sent to this address.

Activate authentication Activate this option if your SMTP server requires authentication. You will then
have to enter the user name and password.

The Show password option is provided to facilitate the input. Once you have
confirmed the password, it is no longer visible.

Maximum message size (MB) Determine the maximum size of the email in MB.

Emails that exceed this size are split into multiple emails.

Maximum number of
attachments

Determine the maximum number of email attachments.
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If this number is exceeded, the attachments are distributed between multiple
emails.

Connection test Click on this button to check the connection to the SMTP server. Depending
on the result, a red or green symbol appears:

· Green symbol: Indicates problem-free communication.

· Red symbol: Indicates a problem with the communication. In this case will
you see an error message  if you hover the mouse over the symbol.

· If you enter a name instead of an IP address under server name, and if in the network
settings  for DHCP mode the option No DHCP is selected, you must also enter a
DNS server in the network settings. This is necessary so that the specified server name
can be resolved.

· Some SMTP servers automatically create their own sender address. The recipient then
sees the sender address set by the SMTP server, and not the email sender address
entered here. Replies to the email still reach the original email sender address.

4. In the third step, you can enter details for the proxy server, if applicable:

You have the following options:

Use proxy server Select this option if you need to specify a proxy server in order to leave the
company network.

Server name Enter the name of the proxy server here:

· Full network name of the proxy server, e.g. proxy.company.com
or

· IP address of the proxy server

114

151



110

Server port Enter the TCP port of the proxy server here.

Authentication type Determine the type of authentication of the proxy server. For the options
Basic and NTLM, you must also specify the user name and password.

The Show password option is provided to facilitate the input. Once you have
confirmed the password, it is no longer visible.

Connection test Click on this button to test the connection to the proxy server. Depending on
the result, a red or green symbol appears:

· Green symbol: Indicates problem-free communication.

· Red symbol: Indicates a problem with the communication. In this case will
you see an error message  if you hover the mouse over the symbol.

5. Click Finish to save the communication channel for the controller.

· If you enter a name instead of an IP address under server name, and if in the network
settings  for DHCP mode the option No DHCP is selected, you must also enter a
DNS server in the network settings. This is necessary so that the specified server name
can be resolved.

· For detailed information about the configuration data for the proxy server, contact your IT
department or system administrator.

How to edit the email communication channel
1. Select the email communication channel in the expanded overview on the left.

2. Under Communication channels in the main panel, click on Edit . Make the required entries in the
respective steps of the wizard.

3. Click on Finish to apply your changes.

8.7.1.3 Adding/editing outputs for the email communication channel

For an email output, configure the email that is sent. You define when and how the email is triggered, the
recipient(s) of the email, the text of the email and which data is provided in the attachment. You can create
multiple email outputs.

How to create the outputs for the email communication channel
1. In the expanded overview on the left, click on the email communication channel.

2. Under Outputs for communication channel: email, click on Create to open the wizard. The wizard will
guide you through the three steps of the creation process.

3. The first step is to configure the e-mail settings, including the name, recipients and the text of the e-mail:
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You have the following options:

Name Enter the name under which the email output is to appear in the system.

The name can be up to 50 characters long and must be different from all
names already in use.

Recipients Enter the email addresses to which the email should be sent. You can enter up
to 200 characters. Use commas to separate multiple email addresses:

name1@company.com, name2@company.com

Subject Enter the text of your choice as the subject of the email. You can enter up to
200 characters.

To the right of the input field, you will see a selection list with text
variables. You can use these variables, for example, to automatically include
the device name or serial number in the subject line.

Content Enter the text of your choice with a maximum of 5000 characters as the
content of the email.

To the right of the input field, you will see a selection list with text
variables. You can use these variables, for example, to automatically include
the device name or serial number in the subject line.

Language Here you can select the language in which the text variables in the email sent
are to be displayed.

This setting only affects the text variables. The subject and content appear
in the email exactly as you have entered them.

4. Click on Next to move to the second step. Here you select the email data to be included as an attachment:

mailto:name2@company.com
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You have the following options:

List of measurement jobs Here you can define for each measurement job whether characteristic
values, time signals, or classification data (special version) are to be sent
as an attachment.

Expert settings:
Data transfer mode

Select this option at the bottom left to display the data transfer mode
selection list above the measurement jobs. You have the following options:

· Transmit most recently computed values: only the current values are
transferred.
Select this option if you have a permanent connection to the Internet and
always want to be informed about the current situation.

· Mass transfer of saved values: the data saved in the device (trends, time
signals, classification data) is sent.
Select this option if you want to transfer data in larger blocks, for example,
because the SmartCheck or ProLink device only has intermittent access to
the Internet.

If you do not select any data, the email will be sent anyway. In this case, the email provides
information that the SmartCheck or ProLink device and the email connection are intact.

5. Click on Next to proceed to the third step. Here you configure the email initiator. You can use a time-
controlled trigger and/or an alarm-based trigger:
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You have the following options:

Send email at intervals Select this option to send the email based on regular time intervals. You have
the following options:

· Start date and start time: Enter the time at which the email should be
sent for the first time.

· Repetition interval: Define the regularity with which the email is to be
sent. You can enter the interval in minutes, hours, days, weeks and
months.

Send email if there is a
change in alarm status

Select this option to send the email when the alarm status changes in one of
the selected measurement jobs. You have the following option:

· Minimum time interval between two alarm emails: This option lets you
specify the minimum time that elapses between two alarm emails. This
enables you to prevent too many emails from being sent if the alarm status is
subject to frequent changes.
If you select the option As often as possible, an email is sent with every
change of alarm.

6. Click on Finish to close the wizard and confirm the email output.

If you set the start date to the 31st of a month, in shorter months the email will still be sent
on the last day of the month.

How to edit the outputs of the email communication channel
1. In the expanded overview on the left, click on the email communication channel.

2. Under Outputs for communication channel: email, click on Edit to open the wizard.

3. Make the desired changes with the assistance of the wizard and confirm them by clicking on Finish.
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8.7.1.4 Error messages during connection test

The Communication channels area and the wizard for adding the email communication channel feature buttons
to test the connection to the SMTP server or proxy server. If the test was unsuccessful, move the mouse over the
red symbol to learn more about the error and receive recommendations for action.

The following messages may appear: Click on a link to jump to the corresponding location in the manual:

· The server name of the SMTP server cannot be resolved. Please check the server name .

· The connection to the SMTP server has failed. Please check the port or the encryption protocol .

· The SMTP server is responding with an incorrect protocol. Please check the encryption protocol .

· The authentication on the SMTP server has failed. Please check your user name and password .

· The SMTP server is unavailable.

· The proxy server name cannot be resolved. Please check the server name .

· The connection to the proxy server has failed. Please check the port or the encryption protocol .

· The authentication on the proxy server has failed. Please check your user name and password .

8.7.2 Communication channel for controllers

Industrial plants use controllers that contain data such as process parameters; this data is extremely useful for

vibration monitoring purposes. In the  Communication channels (controllers)  area, you can integrate this
data into the monitoring using the Schaeffler SmartCheck or ProLink device, and render controller data from the
Schaeffler SmartCheck or ProLink device accessible. In order to avail of this potential, the following steps must be
taken:

· The controller that you would like to integrate must first be added as a communication channel . In doing so
you essentially define the name of the controller and how the Schaeffler SmartCheck or ProLink device can
connect with the controller via your network.

It is also possible to configure station forwarding in the Schaeffler SmartWeb software for accessing the remote
controller in the internal controller network.

· For problem-free communication between the controller and the Schaeffler SmartCheck or ProLink device, there
must be an Ethernet connection between the two. You must also configure the correct settings for the IP
address, net mask and the gateway, if applicable.

· If multiple Schaeffler SmartCheck or ProLink devices are to communicate with one controller, an individual port
must be reserved in the controller for each device.

· If you would like to read data from the controller, you must create one or more inputs for the controller . For
this type of input, you can determine how often and from which controller registers the data is read, as well as
the value range. You also specify the signal unit and signal value range to which the register data is to be
converted.

For each controller, you can set up as many inputs as you wish and use them in the SmartWeb software in
exactly the same way as you use the inputs found in the Input configuration  area; inputs are available for
the controller in relation to measurement jobs , measurement conditions  and measurement triggers  in
particular.

· If you would like to make controller data from the SmartCheck or ProLink device accessible, you must create a
configuration file with outputs for the controller . Here, you define the update frequency and the
characteristic values for which the alarm status and/or a value is relayed, as well as the controller register to which
the information is written.

At the present time, the only communication channels that you can integrate are Mitsubishi
controller families that support the SLMP (3E-Frame) protocol and which are connected to
the Schaeffler SmartCheck or ProLink device via Ethernet. These are the following controller
families:

· System Q

· L series

· System Q and L series via SLMP gateway

There are plans to offer support for additional controllers; for more information, contact your
customer support representative.
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8.7.2.1 Communication channel for controllers area

In the Communication channels area, the expanded overview on the left shows the controllers that you have
created for the SmartCheck or ProLink device. In the right-hand main panel, you will find basic details about the
currently selected controller as well as information on its inputs and outputs, if these have been created:

Click on a controller in order to access the following information and functions in the main panel:

Communication channels

Here you can find the basic information and functions for the selected controller:

· In addition to Name, Device type and IP address, basic settings for addressing the device can be
found here. You can find the change details for the controller in the yellow box at the top right.

· Network number and Station number are details required for station forwarding, if this is defined for
the controller.

· Register with version number relates to the configuration file with outputs that you have created
for the controller: here you can find the register into which the version of the configuration file
(Configuration version) is written. This number functions as a safeguard  against unintentional
overwriting of the register.

· : If you select a controller, this icon is updated; it indicates whether communication with the
controller is functioning or not: a green icon indicates problem-free communication. If the icon is red,
there is a communication problem. In this case you see an error message if you hover the mouse over
the icon.

To update the icon again you must click on .

· Click on  to test the connection to the controller.

· Click on  to download the configuration file. When you have created outputs for the controller ,
you need this file in order to prepare the controller for the data transfer.

· Click on Edit  to edit the controller. For details, please refer to Adding/editing a controller .

· Click on Add  to add further controllers. For details, please refer to Adding/editing a
controller .

125

122

118

117



116

· You can also delete the selected controller. To do so, click Delete  and confirm with OK.

· In the top right corner, click on  to open the Configuration overview .

A controller that you have integrated into a measurement job  cannot be deleted. In this

case, the Delete  button is deactivated. To delete this controller, you must first delete
the measurement job in which it is used.

Inputs for communication channel
This table provides an overview of the inputs that you have created for the selected controller. When
you select a controller, the following information and options are displayed here:

· The table contains information on the relevant inputs, in addition to the Name e.g. also the register in
which the controller starts reading the data (Start register), the signal value range into which the
data is translated (Min. signal to Max. signal) and the register value range it covers (Min. reg. value
to Max. reg. value).

· Click on Edit  to edit the input. For details, please refer to Adding/editing a controller input .

· Click on Add  to add further inputs. For details, please refer to Adding/editing a controller
input .

· You can also delete the selected input. To do so, click Delete  and confirm with OK.

An input that you have linked to a measurement job  cannot be deleted. In this case, the

Delete  button is deactivated. To delete this external device, you must first delete the
measuring job in which it is used.

Outputs for communication channel
You can use characteristic values that are calculated in the SmartCheck or ProLink device to transfer their
alarm status and/or values to a controller. To do this, create a configuration file with outputs and transfer
the alarm status and/or value of selected characteristic values via this file to the controller.

If you have already created outputs for the controller, the following information can be found in the
Outputs for communication channel area:

· The table indicates the characteristic values for which the alarm status and/or value (Type) is
transferred to the controller, how often this happens (Update interval) and the register into which
the information is written.

· Click on Edit  to edit the outputs with the assistance of the wizard. For more details, please refer to
Creating/editing controller outputs .

· Click on Create  to create the outputs with the assistance of the wizard. For more details, please
refer to Creating/editing controller outputs .

· You can also delete the outputs. To do so, click Delete  and confirm with OK.

· After you have created or edited the controller outputs in the SmartWeb software, you
must transfer the corresponding information to your controller. For details, please refer to
the section Integrating a controller into the system .

· If you want to use the Schaeffler SmartUtility software (optional) to download a
configuration from the SmartCheck or ProLink device and send this to other devices, the
outputs for the controller are not included in the transfer. This prevents multiple
Schaeffler SmartCheck or ProLink devices from writing to the same controller register. In
this case, please import the configuration file with the outputs manually, as described in
the section Integrating a controller into the system .
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8.7.2.2 Adding/editing a controller

In order to be able to receive the data from a controller as an input signal, you will need to set up the relevant
controller as a communication channel and communicate the network data of the controller to the SmartCheck or
ProLink device.

How to create a communication channel for a controller

1. Under Communication channels, click on Add to open the wizard. The wizard will guide you through the
process of creating the communication channel in two steps.

2. In the first step, under Communication channel type, select the controller for which you are creating the
communication channel. Currently, you can only integrate Mitsubishi controller families  that support the SLMP
(3E-Frame) protocol.

3. Click on Next to move to the second step. Here you must enter the required details for the controller:

You have the following options:

Name Enter the name with which the controller is to appear in the SmartWeb
software.

IP address Enter the IP address under which the controller can be accessed in your
network.

Port Enter the port via which the connection to the controller is established.

Station forwarding Activate this field if you would like to forward the communication to another
controller via the IP address specified above. In this case you must also specify
the following:

Network number: specify the network number of the remote controller here.

Station number: specify the station number of the remote controller here.
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Example:
In order to access the PLC 3 controller, specify the following:
- the IP address of PLC 1
- the network number and station number of PLC 3:

The data from the Schaeffler SmartCheck or ProLink device is then forwarded by PLC 1 to
PLC 3 via the realtime network.

Protocol
Transfer mode

Enter the Network protocol and the Transfer mode for transferring data
between the Schaeffler SmartCheck or ProLink device and the controller.

Make sure that your selection here matches the settings in the controller.

Connection test Click on this button to check the input connection data. If the test is
successful, the box next to the button turns green; otherwise it appears in
red.

If you hover the mouse above the red box you will also receive a message
explaining why the connection is not working.

4. Click Finish to save the communication channel for the controller.

· For the connection between Schaeffler SmartCheck or ProLink and the controller to work,
the IP addresses of both devices must be in the same range. That means that - depending
on the net mask - the first three numbers of the four-digit IP address must be identical.
You can also access the controller with the Schaeffler SmartCheck or ProLink device via a
gateway. If you have any questions regarding this, contact your network administrator.

· If the IP address of the controller is outside the IP range of the Schaeffler SmartCheck or
ProLink device, but is accessible via a gateway, proceed as follows:

1. Open the Schaeffler SmartUtility Light or Schaeffler SmartUtility software (optionally
available).

2. Click on Configure sensor(s).
3. In the first step in the wizard, select the Schaeffler SmartCheck or ProLink device.

4. In the second step in the wizard, specify the gateway for the Schaeffler SmartCheck or
ProLink device.

5. Close the Wizard with Send.

You can obtain more detailed information about creating a gateway from your system
administrator. For details on working with the Schaeffler SmartUtility software, refer to the
relevant manual.

· The combination of IP address and port must be unique. If you need more combinations –
for station forwarding, for example – you must enable more ports in the controller as
appropriate.

How to edit the communication channel for a controller
1. Select the controller in the expanded overview on the left.

2. Under Communication channels in the main panel, click on Edit . Make the required entries in the
respective steps of the wizard.
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3. Click on Finish to apply your changes.

8.7.2.3 Adding/editing inputs for controllers

The Schaeffler SmartCheck or ProLink device receives information about process parameters in the controller via
controller inputs.

How to create inputs for the controller
1. In the expanded overview on the left, select the controller for which you would like to add an input.

2. Under Inputs for communication channel: [Name of the controller], click on Add .

3. In the Add input window, make the desired entries:

You have the following options:

Name Here, specify the name that the input is to appear under in the SmartWeb
software.

Start register Specify the register here that is to be read out. If you choose a data type
under Register type for which two registers must be read out, Start
register refers to the lower of the two registers. This is where the readout
starts.

Register type This is where you specify the data format to be used in the Start register or
in the register closest to the start register. This specification defines:

· whether one register (16 bits) or two registers (32 bits) are read out and

· how large the maximum register value range can be.

The selection options available have the following formats or register value
ranges:

INT 16 bit -32,768 to 32,767

WORD 16 bit 0 to 65,535

DINT 32 bit -2,147,483,648 to 2,147,483,647



120

DWORD 32 bit 0 to 4,294,967,295

REAL 32 bit ±1.5 * 10-45 to ±3.4 * 1038

Unit group and

Unit
This is where you specify the physical value and measurement unit into which
the value from the controller is to be converted.

Polling interval This is where you specify how often the value is to be queried from the
controller.

A long polling interval is sufficient for values that only change slowly e.g. the
temperature. This can reduce the amount of data and the load on the
controller.

The logbook message "Connection refused" indicates
that the Schaeffler SmartCheck or ProLink device is
attempting to connect to the controller again, although
the last connection is not yet complete. You can
prevent this from occurring by increasing the polling
interval.

Register value Initially, these fields are filled automatically as soon as you have selected a
Register type. You then have the option of adjusting the Min. register
value and/or Max. register value manually. This may be necessary if the
register value range is smaller than the range that was set automatically.

Signal value Use these settings to determine the range within which the measurement
values should lie. First enter a minimum value Min. Then enter a maximum
value Max or define the factor with which the calculated signal should be
scaled in the Scaling field. Both the diagram and the values of the respective
other field are then adjusted automatically.

4. Click on OK to save the new input.

Example:

The register R100 is defined as WORD in the controller. The entire numerical range from 0 to 65,535 is
limited to the range from 0 to 10,000. This range corresponds to a speed of between 0 and 3000 RPM.
Your settings are then the following:

Start register R100

Register type WORD

Unit group Frequency/speed

Unit RPM

Min. register value 0

This value is set automatically.

Max. register value 10,000

The number 65,535 is set automatically and you will need to adjust it manually.

Max. signal value 3000 (RPM)

Min. signal value 0 (RPM)

How to add a scaling factor to the input
You can add scaling factors to the input, which you can access e.g. when creating a measurement job . Using
scaling factors, you can calculate logical values for other areas from the physical value measured at one area of the
component.

Example: Using the input, you measure the speed in front of the gear. The speed behind the gear is 5
times smaller. You can create a scaling factor for this:
1. Speed in front of the gear
2. Speed behind the gear with a factor of 0.2 (1/5)

1. In the table, selected the required input under Inputs for communication channel: [Name].
2. Click on  to expand the list of scaling factors.
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3. Click on  to open the Add scaling factor window:

You have the following options:

Name The scaling factor is listed under this name, along with the other inputs. Therefore,
you should choose a practical name that will enable you to distinguish between the
inputs.

Scaling factor The physical input signal is multiplied by the value you enter here.

Unit Here you can change the unit of measurement for the sensor signal. By default, the
unit of the corresponding input configuration is selected here.

4. Click on OK to save your changes. The new scaling factor is displayed in the list of scaling factors.

To delete or edit the scaling factor, right-click to open the context menu and select the corresponding command
here:

You can also switch to the live view  area here. There you will see in real time the signal used for the calculation
of this characteristic value.

If you delete a scaling factor which is being used by a measurement job, the system gives
you a warning message. If you delete the scaling factor, you also automatically delete the
relevant measurement job.

How to edit the input of a controller
1. In the expanded overview on the left, select the controller whose input you would like to edit.

2. In the table, under Inputs for communication channel: [Name of the controller], selected the desired
input.

3. Click on Edit  and make the desired entries in the Edit input window.

4. Click on OK to accept your changes.
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8.7.2.4 Adding/editing outputs for controllers

CAUTION Only create a configuration file with outputs for the controller if you are certain that the
register area to be written to is free, and that it is not used in the controller program.
Otherwise, it is possible that the Schaeffler SmartCheck or ProLink device may overwrite
important data in your controller.

You can use the outputs to define the characteristic values whose alarm status, value, and/or alarm limit is
transferred to the controller. Here, you can also determine the registers of the controller that will be written to in
this process. In addition, you require certain information from the outputs to prepare your controller for the writing
process. For more details, refer to the relevant section of the chapter Integrating a controller into the
system .

If you have created the configuration file with outputs successfully and have also prepared the controller
appropriately, the Schaeffler SmartCheck or ProLink device can write the following values for each characteristic
value into the relevant controller register:

Value Abbreviation Meaning

1 no_alarm Alarm status: No alarm - marked in green in the Schaeffler
SmartWeb software.

2 pre_alarm Alarm status: Pre-alarm - marked in yellow in the Schaeffler
SmartWeb software.

3 main_alarm Alarm status: Main alarm - marked in red in the Schaeffler
SmartWeb software.

4 charval_error An error occurred when calculating the characteristic value; it is
possible for example that no rotational speed was determined,
even though this is necessary for the characteristic value.

5 value Value: Number in IEEE 32-bit format

How to create the outputs for the controller
1. In the expanded overview on the left, select the controller for which you would like to create the outputs.

2. Under Outputs for communication channel: [name of the controller], click on Create  to open the
wizard. It will guide you through the creation process in two steps.

3. In the first step, you must select registers and characteristic values:
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You have the following options:

Start register This is the point where you specify the first register of the register block in
which the alarm status is to be stored.

The version number of the configuration file is stored in this first register with
the outputs; the alarm statuses and/or values of the selected characteristic
values are written into all subsequent registers.

Update interval This is where you specify how often the alarm statuses and/or values are to be
transferred to the controller.

Characteristic value
selection

This is where you select the characteristic values whose alarm statuses and/or
values are to be transferred to the controller. The characteristic values available
here depend on the measurement jobs  that you have created.

Alarm status/alarm limits Select here if you want to transfer the alarm status, value, and/or the alarm
limit of the characteristic value to the controller for every characteristic value.
You can only transfer the communication status, the device status and the
overriding alarm characteristic value ("basic configuration" here, for example) as
alarm statuses. You can then only select the device status if at least one other
characteristic value transfers an alarm status.

The alarm limits cannot be selected until the value
and/or alarm status has been selected.

Measurement triggers and measurement conditions cannot be selected as a configuration for
an output.

4. Click on Next to move to the second step. This is where you specify the register name:
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Under Register names, you can use the relevant register as a variable in the GX Works2 software.

As far as possible, the register names in the table are generated automatically from the characteristic value names.
The sequence of the entries can be edited by selecting one or more entries and moving them up or down with

the arrow keys. You can update the register with update . The characteristic values are sorted alphabetically
by measuring task name and characteristic value name. You can edit any name by double-clicking on the relevant
line. The following naming conventions apply:

· The name must be input in ASCII format.

· A-Z, a-z, 0-9 and _ are allowed characters

· The first character must be a letter.

· The number of characters must be between 1 and 32 at most.

5. Click on Finish to close the wizard and confirm the configuration with outputs.

6. To guarantee problem-free communication, you must also transfer the configuration file with outputs to your
controller. In the controller's programming environment, the registers into which the Schaeffler SmartCheck or
ProLink device will write the alarm status, values, and/or alarm limits is marked as 'reserved'. For details, please
refer to the section Integrating a controller into the system .125
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· The Register with version number contains the current version number of the
configuration file with outputs. This information functions as a safeguard against
unintentional overwriting of registers: when the configuration file has changed in such a
way as to affect the configuration of the controller, the version number for the controller
in question is immediately incremented. This means that the version number in the
controller no longer agrees with the version number on the Schaeffler SmartCheck or
ProLink device. Alarm statuses and/or values can no longer be written into the controller,
and you will receive an error message.

The alarm statuses and/or values are not written into the controller again until you have
transferred the new configuration file to the controller (see section Integrating a
controller into the system ).

· The characteristic value Communication status writes values into the controller that
provide information about communication problems between the Schaeffler SmartCheck or
ProLink device and the controller.

Value Abbreviation and meaning

0 communication_ok: No problems

1 error_configuration_inconsistent: The characteristic value structure on
the Schaeffler SmartCheck or ProLink device has changed; the data can no
longer be written into the controller at this time. In order to do this again,
the configuration file from the Schaeffler SmartCheck or ProLink device
must be downloaded again and read into the controller .

2 error_reading_values:The Schaeffler SmartCheck or ProLink device
cannot read one or more values from the controller, or the values are
incorrect. For more information, refer to the Logbook .

3 error_alarm_state_not_updated: The Schaeffler SmartCheck or ProLink
device cannot write one or more values to the controller. For more
information, refer to the Logbook .

How to edit the outputs of a controller
1. In the expanded overview on the left, select the controller for which you want to edit the outputs.

2. Under Outputs for communication channel: [name of the controller], click on Edit  to open the
wizard.

3. Make the desired changes with the assistance of the wizard and confirm them by clicking on Finish.

4. To guarantee problem-free communication, you must also transfer the changed configuration file to your
controller. For details, please refer to the section Integrating a controller into the system .

8.7.2.5 Integrating a controller into the system

In the following sections you will find a detailed example of how to integrate specific controllers into the Schaeffler
SmartCheck or ProLink device as communication channels, and the steps required in order to initiate communication
between your controller and the Schaeffler SmartCheck or ProLink device. The following example is currently
available:

· Mitsubishi - GX Works2 software

In this section, you will find detailed information regarding how to prepare your controller for communication with
the Schaeffler SmartCheck or ProLink device and the settings in the Schaeffler SmartWeb software that are
required for this. Here is an overview of the necessary steps:

1. Set up communication settings in the controller
2. Create the controller in the SmartWeb software
3. Create inputs for the controller in the SmartWeb software
4. Create outputs for the controller in the SmartWeb software
5. Save the configuration file with outputs in the SmartWeb software
6. Import configuration file into GX Works2
7. Compile program and transfer it to the controller
These steps are aligned with the sample specifications you will find in the Initial situation  section.
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Initial situation
The following communications parameters apply to your Mitsubishi controller:

IP address of the controller 172.28.205.122

Port (Host Station Port No.) Decimal: 1280 or hexadecimal: 0500

Network protocol TCP (MC protocol)

Transfer mode (Communication
Data Code)

Binary

Station forwarding None

You would like to use the connection between the controller and the Schaeffler SmartCheck or ProLink device as
follows:

· You would like to read the rotational speed information from register D1000 of the controller. This register has
the WORD register type, and a possible value range 0-10,000, which should in turn be transformed to the 0-3000
RPM signal range.

· In addition, the Schaeffler SmartCheck or ProLink device must write the alarm status of the basic configuration
and the alarm status and value of the ISO characteristic value into the Mitsubishi controller registers. This writing
process must begin in register D1200.

8.7.2.5.1  Mitsubishi GX Works2 softw are

Step 1: create communication settings in the controller
First set all the parameters required for communication with the Schaeffler SmartCheck or ProLink device:

1. Start the GX Works2 software.

2. Click on Project > Open.

3. Open the project that contains the program for your controller.

4. In the navigation window, double-click on Parameter > PLC Parameter.

5. In the Built-in Ethernet Port Setting tab, click on Open Setting.
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6. Enter the following settings:

Protocol TCP

Open System MC Protocol

Host Station Port
No.

decimal: 1280 (corresponds to hexadecimal: 0500)

7. Click on End to accept the settings.
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8. Under Communication Data Code, set the Binary Code transfer mode.

9. Activate Enable online change (FTP, MC Protocol) so that the Schaeffler SmartCheck or ProLink data can be
written into the controller.

10. Click on End.

11. Integrate the program into the Task.
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12. Compile the program by selecting Compile > Rebuild All in the menu.

13. Transfer the program to the controller.

Continue configuring the controller in the Schaeffler SmartWeb software.

Step 2: Create the controller in the Schaeffler SmartWeb software
Under Communication channels, click on Add to open the wizard. The wizard will guide you through the creation
of the communication channel in two steps:

· In the first step, select the controller for which you want to create the communication channel.

· In the second step, enter the following details about the controller:
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Name PLC_018

IP address 172.28.205.122

Port decimal: 1280 (corresponds to hexadecimal: 0500)

Protocol TCP

Transfer mode Binary

For further information on how to create a controller, please refer to the section Adding/editing a controller .

You can click on the Connection test button to verify your entries: if the area next to it
turns green your information is correct.

Step 3: Create inputs for the controller in the SmartWeb software
Under Inputs for communication channel: PLC_018, click on Add and enter the following settings in the Add
input window:
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Name Speed from PLC_018

Start register D1000

Register type WORD

Unit group Frequency/speed

Unit RPM

Register value Change the value for Max to 10,000.

Signal value For Min, enter the value 0 and for Max, enter the value 3000.

For more information on how to create an input for the controller, refer to the section Adding/editing inputs for
controllers .

· If you have created inputs in the Schaeffler SmartWeb software, you can use the live
view  to check whether data is being received by the Schaeffler SmartCheck or ProLink
device.

· This input can be used exactly like an internal input for measuring jobs

Step 4: Create outputs for the controller in the SmartWeb software
Under Outputs for communication channel: PLC_018, click on Create and enter the following settings in the
first step of the wizard:
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Start register D1200

Update interval This is where you specify how often the alarm statuses and/or values are to be
transferred to the controller.

Available characteristic
values

Select the alarm status for the base measurement job characteristic value and
the alarm status and value for the ISO 10816-1 characteristic value. To do this,
click on the box next to the characteristic value.

In the second step of the wizard, you can, if necessary, adjust the Register names that have been assigned
automatically. For more information about how to create a configuration with outputs for the controller, refer to the
section Adding/editing outputs for controllers .

Step 5: Save the configuration file with outputs for the controller in the SmartWeb software

1. In the  Communication channels area, click on the desired Controller (for example: PLC_018).

2. Click on Download to download the configuration file with outputs for the controller.

3. Open the configuration file:
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4. Select the contents of the new window with CTRL+A, copy them to the clipboard with CTRL+C and insert
them into an editor (e.g. Microsoft Editor) with CTRL+V.

5. Save the file with any name and the extension .ASC (Example: SmartCheck or ProLink01.asc).

· If you use the Mozilla Firefox browser, you can save the file directly as an ASCII file with
the Save as function.

· Please make sure that the file has the extension .ASC so that it can be read by the GX
Works2 software.

Step 6: Read the configuration file into GX Works2

Please create a backup copy of the existing project before importing the Schaeffler
SmartCheck or ProLink configuration file.

1. Click on Project > Open Other Data > Read ASC Format File.

2. Select the ASCII file (.ASC) you have just created and click on OK.

3. The Schaeffler SmartCheck or ProLink configuration file is imported and inserted into the tree as a new Global
Label with the designation Global_Vars.
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The characteristic values along with the associated registers are displayed if you click in the Device column on
Detail Setting:

Step 7: compile the program and transfer it to the controller
1. Compile the program by selecting Compile > Rebuild All in the menu.

2. Save the program and transfer it to the controller.

8.7.2.5.2  Mitsubishi GX IEC Developer softw are

Step 1: create communication settings in the controller
First set all the parameters required for communication with the Schaeffler SmartCheck or ProLink device:

1. Start the GX IEC Developer software.

2. Click on Project > Open.

3. Open the project into which the Schaeffler SmartCheck or ProLink configuration file is to be imported.

4. In the navigation window, double-click on Parameter > PLC Parameter.
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5. In the Built-in Ethernet port tab, click on Open settings.

6. Enter the following settings:

Protocol TCP

Open System MC Protocol

Host Station Port
No.

decimal: 1280

7. Click on End to accept the settings.
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8. Under Communication Data Code, set the Binary Code transfer mode.

9. Activate Enable online change (FTP, MC Protocol) so that the Schaeffler SmartCheck or ProLink data can be
written in the controller.

10. Click on End.

11. Integrate the program into the Task.

12. Compile the program by selecting Compile > Rebuild All in the menu.

13. Transfer the program to the controller.

Continue configuring the controller in the Schaeffler SmartWeb software.
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Step 2: Create the controller in the Schaeffler SmartWeb software
Under Communication channels, click on Add to open the wizard. The wizard will guide you through the creation
of the communication channel in two steps:

· In the first step, select the controller for which you want to create the communication channel.

· In the second step, enter the following details about the controller:

Name PLC_018

IP address 172.28.205.122

Port decimal: 1280 (corresponds to hexadecimal: 0500)

Protocol TCP

Transfer mode Binary

For further information on how to create a controller, please refer to the section Adding/editing a controller .

You can click on the Connection test button to verify your entries: if the area next to it
turns green your information is correct.

Step 3: Create inputs for the controller in the SmartWeb software
Under Inputs for communication channel: PLC_018, click on Add and enter the following settings in the Add
input window:
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Name Speed from PLC_018

Start register D1000

Register type WORD

Unit group Frequency/speed

Unit RPM

Register value Change the value for Max to 10,000.

Signal value For Min, enter the value 0 and for Max, enter the value 3000.

For more information on how to create an input for the controller, refer to the section Adding/editing inputs for
controllers .

· If you have created inputs in the Schaeffler SmartWeb software, you can use the live
view  to check whether data is being received by the Schaeffler SmartCheck or ProLink
device.

· This input can be used exactly like an internal input for measuring jobs

Step 4: Create outputs for the controller in the SmartWeb software
Under Outputs for communication channel: PLC_018, click on Create and enter the following settings in the
first step of the wizard:
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Start register D1200

Update interval This is where you specify how often the alarm statuses and/or values are to be
transferred to the controller.

Available characteristic
values

Select the alarm status for the base measurement job characteristic value and
the alarm status and value for the ISO 10816-1 characteristic value. To do this,
click on the box next to the characteristic value.

In the second step of the wizard, you can, if necessary, adjust the Register names that have been assigned
automatically. For more information about how to create a configuration with outputs for the controller, refer to the
section Adding/editing outputs for controllers .

Step 5: Save the configuration file with outputs for the controller in the SmartWeb software

1. In the  Communication channels area, click on the desired Controller (for example: PLC_018).

2. Click on Download to download the configuration file with outputs for the controller.

3. Open the configuration file:
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4. Select the contents of the new window with CTRL+A, copy them to the clipboard with CTRL+C and insert
them into an editor (e.g. Microsoft Editor) with CTRL+V.

5. Save the file with any name and the extension .ASC (Example: SmartCheck or ProLink01.asc).

· If you use the Mozilla Firefox browser, you can save the file directly as an ASCII file with
the Save as function.

· Please make sure that the file has the extension .ASC so that it can be read by the GX
Works2 software.

Step 6: Read the configuration file into GX Works2

Please create a backup copy of the existing project before importing the Schaeffler
SmartCheck or ProLink configuration file.

1. Click on Project > Open Other Data > Read ASC Format File.

2. Select the ASCII file (.ASC) you have just created and click on OK.

3. The Schaeffler SmartCheck or ProLink configuration file is imported and inserted into the tree as a new Global
Label with the designation Global_Vars.
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The characteristic values along with the associated registers are displayed if you click in the Device column on
Detail Setting:

Step 7: compile the program and transfer it to the controller
1. Compile the program by selecting Compile > Rebuild All in the menu.

2. Save the program and transfer it to the controller.

8.7.3 Communication channel for OPC UA server

OPC UA is a standard that enables devices to communicate and exchange data. In the  Communication
channels (OPC UA server)  area you can configure the Schaeffler SmartCheck or ProLink device as an OPC UA
server. The characteristic values of the device can then be read out by other controllers. You can also integrate
process parameters of other controllers into the SmartCheck or ProLink device via OPC UA server inputs. In order to
avail of this potential, the following steps must be taken:

· You must first add the OPC UA server as a communication channel . In doing so you essentially define the
server port and any authentication data.

· If you want to read data from other controllers via the OPC UA server, you must create one or more inputs for
the OPC UA server  for this purpose. For this type of input, you can determine how often the data is read
from the controller registers, as well as the value range. You also specify the signal unit and signal value range to
which the register data is to be converted.
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· You can create as many inputs for the OPC UA server as you wish and use them in the SmartWeb software in
exactly the same way as you use the inputs found in the Input configuration  area. In particular, inputs are
available for the server in relation to measurement jobs , measurement conditions  and measurement
triggers .

· Use an OPC UA client to check which data is available via the OPC UA server. You can then download the values
in a readable format from the OPC UA server.

8.7.3.1 Communication channel area for the OPC UA server

In the Communication channels area, the expanded overview on the left shows the OPC UA server that you
have created for the Schaeffler SmartCheck or ProLink device. In the right-hand main panel, you will find basic
details about the OPC UA server as well as information on its inputs, if these have been created:

Click on an OPC UA server to access the following information and functions in the main panel:

Communication channels
Here you can find the basic information and functions for the OPC UA server:

· Alongside the Name, you will see the Server port used.

· If authentication is activated for the OPC UA server, you will also see the User name and Password
details.

· Click on Add  to add an OPC UA server. For details, please refer to Adding/editing an OPC UA
server .

· Click on Edit  to edit the OPC UA server. For details, please refer to Adding/editing an OPC UA
server .

· You can delete the OPC UA server communication channel. To do so, click Delete  and confirm with
OK.

· In the top right corner, click on  to open the Configuration overview .

Inputs for communication channel
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This table provides an overview of the inputs that you have created for the OPC UA server. The following
information and functions are to be found here:

· The table contains information on the relevant inputs in addition to the Name, e.g. the signal value
range into which the data is translated (Min. Signal to Max. Signal), the register value range it
covers (Min. reg. value to Max. reg. value), and at which interval the value is queried.

· Click on Edit  to edit the input. For details, please refer to Adding/editing an OPC UA server
input .

· Click on Add  to add further inputs. For details, please refer to Adding/editing an OPC UA server
input .

· You can delete the selected input. To do so, click Delete  and confirm with OK.

An input that you have linked to a measurement job  cannot be deleted. In this case, the

Delete  button is deactivated. To delete this external device, you must first delete the
measuring job in which it is used.

8.7.3.2 Adding/editing an OPC UA server

To use the Schaeffler SmartCheck or ProLink device as an OPC UA server, you must create the corresponding
communication channel.

How to create the communication channel for the OPC UA server

1. Under Communication channels, click on Add to open the wizard. The wizard will guide you through the
process of creating the communication channel in two steps.

2. In the first step, select the OPC UA server communication channel type.

3. Click on Next to move to the second step. You must enter the required details for the OPC UA server here:

You have the following options:
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Server port Enter the TCP port of the server on the SmartCheck or ProLink device.

The OPC UA standard specifies the value 4840 for the server
port. Do not change this value unless you possess expert
knowledge.

Activate authentication Activate this option if you want to regulate the readout of the device data. If
this option is activated, you can specify the User name and Password that
must be entered for authentication before using the SmartCheck or ProLink
device for OPC UA communication. Select Show password to make the
password visible while you enter it.

4. Click Finish to save the communication channel for the OPC UA server.

How to edit the communication channel for the OPC UA server
1. Select the OPC UA server in the expanded overview on the left.

2. Under Communication channels in the main panel, click on Edit . Make the required entries in the
respective steps of the wizard.

3. Click on Finish to apply your changes.

8.7.3.3 Adding/editing an OPC UA server input

The Schaeffler SmartCheck or ProLink device receives information about process parameters in other controllers via
OPC UA server inputs.

How to create an input for the OPC UA server
1. Select the OPC UA server in the expanded overview on the left.

2. Under Inputs for communication channel: OPC UA server, click on Add .

3. In the Add input window, make the desired entries:

You have the following options:
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Name Here, specify the name that the input is to appear under in the SmartWeb
software.

Register type This is where you specify the format in which the data is transferred. This
specifies how large the maximum register value range can be.

The following format is currently supported:

FLOAT 32 bit

Unit group and

Unit
This is where you specify the physical value and measurement unit into which
the value from the controller is to be converted.

Polling interval This is where you specify how often the value is to be queried from the
controller.

A long polling interval is sufficient for values that only change slowly e.g. the
temperature. This can reduce the amount of data and the load on the
controller.

Register value Initially, these fields are filled automatically as soon as you have selected a
Register type. You then have the option of adjusting the Min. register
value and/or Max. register value manually. This may be necessary if the
register value range is smaller than the range that was set automatically.

Signal value Use these settings to determine the range within which the measurement
values should lie. First enter a minimum value Min. Then enter a maximum
value Max or define the factor with which the calculated signal should be
scaled in the Scaling field. Both the diagram and the values of the respective
other field are then adjusted automatically.

4. Click on OK to save the new input.

Speed input example:

The speed in your application is between 0 and 3000 RPM. In the register, this corresponds to the value
range 0 to 10,000. In order to use this speed as an external input, your settings need to be as follows:

Register type FLOAT

Unit group Frequency/speed

Unit RPM

Min. register value 0

Max. register value 10,000

Max. signal value 3000 (RPM)

Min. signal value 0 (RPM)

How to add a scaling factor to the input
You can add scaling factors to the input, which you can access e.g. when creating a measurement job . Using
scaling factors, you can calculate logical values for other areas from the physical value measured at one area of the
component.

Example: Using the input, you measure the speed in front of the gear. The speed behind the gear is 5
times smaller. You can create a scaling factor for this:
1. Speed in front of the gear
2. Speed behind the gear with a factor of 0.2 (1/5)

1. In the table, selected the required input under Inputs for communication channel: [Name].
2. Click on  to expand the list of scaling factors.

3. Click on  to open the Add scaling factor window:
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You have the following options:

Name The scaling factor is listed under this name, along with the other inputs. Therefore,
you should choose a practical name that will enable you to distinguish between the
inputs.

Scaling factor The physical input signal is multiplied by the value you enter here.

Unit Here you can change the unit of measurement for the sensor signal. By default, the
unit of the corresponding input configuration is selected here.

4. Click on OK to save your changes. The new scaling factor is displayed in the list of scaling factors.

To delete or edit the scaling factor, right-click to open the context menu and select the corresponding command
here:

You can also switch to the live view  area here. There you will see in real time the signal used for the calculation
of this characteristic value.

If you delete a scaling factor which is being used by a measurement job, the system gives
you a warning message. If you delete the scaling factor, you also automatically delete the
relevant measurement job.

How to edit an input for the OPC UA server
1. Select the OPC UA server in the expanded overview on the left.

2. In the table, under Inputs for communication channel: OPC UA server, select the desired input.

3. Click on Edit  and make the desired entries in the Edit input window.

4. Click on OK to accept your changes.

8.7.4 Communication channel for PROFINET

If you have inserted a PROFINET module in the ProLink CPU, it appears automatically as a communication channel in
the Configuration area. With the aid of this communication channel and the correspondingly programmed
controller,  all alarm statuses of the characteristic values and theProLink device can be read via the cyclic data.
Process data can also be sent from the controller to the ProLink device via the cyclic data. To do this, you must
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create the process data of the ProLink device as inputs in the SmartWeb software.  In addition, all characteristic
values and their alarm limits can be queried by the controller in the acyclic data.

The PROFINET module is not automatically detected until firmware version 2.0 or higher and
is displayed as a communication channel. If it does not appear, update your firmware using
the Help > Update firmware  function.

8.7.4.1 Communication channel for PROFINET area

In the communication channels area, you will find the communication channel for the PROFINET module that was
detected on the ProLink device in the overview shown on the left. On the right of the main panel, you will find
basic details about the PROFINET communication channel, as well as information about its inputs:

Click on the PROFINET communication channel to access the following information and functions in the main panel:

Communication channels
Here you can find the basic information and functions for the selected communication channel for
PROFINET:

· In addition to the name, MAC address and firmware version, you will find the station names of the
ProLink device and controller, as well as details on the network configuration.

· Status informs you about the current status of the communication channel:

§ Connected:
The communication channel for PROFINET works without any problems.

§ Deactivated:
 The communication channel for PROFINET has been deactivated via the Edit function .

§ Inactive:
The ProLink device has not yet commissioned the PROFINET module.

§ Idle:
The PROFINET module is not yet connected to a controller.

§ Configuration error:
 The controller is configured incorrectly.

· Click  to download a ZIP file containing information on programming the controller. It contains the
following:
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§ info.txt:
The PROFINET module of theProLink device functions as a DAP (device access point) and has one or
two virtual sub-slots depending on the configuration. The info.txt file contains detailed information
on which modules must be programmed and how and which cyclic and acyclic data ProLinkis
exchanged between the device and the controller.

§ gsd folder:
 In this folder you will find a product image and the gsd.xml file which describes the ProLink
interface in detail.

§ s7 folder:
 This folder contains programming examples for reading cyclic and acyclic data.

· Click on Edit  to edit the PROFINET communication channel. You can then activate, deactivate or
reactivate PROFINET.

· Click on Add  to add further communication channels .

· In the top right corner, click on  to open the Configuration overview .

Inputs for communication channel
Here you will find a tabular view of the inputs that you have created for the PROFINET communication
channel. The following information and functions can be found here:

· The table contains information on the relevant inputs in addition to the name, e.g. the signal value
range into which they are translated (Min. signal to Max. signal), the register value range it covers
(Min. reg. value to Max. reg. value) and the query interval.

· Click on Edit  to edit the input. For details, please refer to Adding/editing inputs for PROFINET
communication channel .

· Click on Add  to add further inputs. For details, please refer to Adding/editing inputs for
PROFINET communication channel .

· You can also delete the selected input. To do so, click Delete  and confirm with OK.

· If you change the measurement tasks, the info.txt file is updated. You must then
download the ZIP file again and adapt the controller programming .

· The ProLink device can be restarted from the controller. In addition, the controller
automatically detects when the ProLink device is switched off or restarted, and it also
indicates this.

8.7.4.2 Adding/editing inputs for PROFINET communication channel

Process data can be transferred from the controller to the ProLink device via inputs for the PROFINET
communication channel.

How to create an input for the PROFINET communication channel
1. Select the PROFINET communication channel in the expanded overview on the left.

2. Under Inputs for communication channel: PROFINET, click on Add .

3. In the Add input window, make the desired entries:
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You have the following options:

Name Here, specify the name that the input is to appear under in the SmartWeb
software.

Register type Only the FLOAT register type is available.

Unit group and

Unit
This is where you specify the physical value and measurement unit into which
the value from the controller is to be converted.

Polling interval This is where you specify how often the value is to be queried from the
controller.

A long polling interval is sufficient for values that only change slowly e.g. the
temperature. This enables you to reduce the amount of data.

Register value Initially, these fields are filled automatically as soon as you have selected a
Register type. You then have the option of adjusting the Min. register
value and/or Max. register value manually. This may be necessary if the
register value range is smaller than the range that was set automatically.

Signal value Use these settings to determine the range within which the measurement
values should lie. First enter a minimum value Min. Then enter a maximum
value Max or define the factor with which the calculated signal should be
scaled in the Scaling field. Both the diagram and the values of the respective
other field are then adjusted automatically.

4. Click on OK to save the new input.

How to add a scaling factor to the input
You can add scaling factors to the input, which you can access e.g. when creating a measurement job . Using
scaling factors, you can calculate logical values for other areas from the physical value measured at one area of the
component.

Example: Using the input, you measure the speed in front of the gear. The speed behind the gear is 5
times smaller. You can create a scaling factor for this:
1. Speed in front of the gear
2. Speed behind the gear with a factor of 0.2 (1/5)

1. In the table, selected the required input under Inputs for communication channel: [Name].
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2. Click on  to expand the list of scaling factors.

3. Click on  to open the Add scaling factor window:

You have the following options:

Name The scaling factor is listed under this name, along with the other inputs. Therefore,
you should choose a practical name that will enable you to distinguish between the
inputs.

Scaling factor The physical input signal is multiplied by the value you enter here.

Unit Here you can change the unit of measurement for the sensor signal. By default, the
unit of the corresponding input configuration is selected here.

4. Click on OK to save your changes. The new scaling factor is displayed in the list of scaling factors.

To delete or edit the scaling factor, right-click to open the context menu and select the corresponding command
here:

You can also switch to the live view  area here. There you will see in real time the signal used for the calculation
of this characteristic value.

If you delete a scaling factor which is being used by a measurement job, the system gives
you a warning message. If you delete the scaling factor, you also automatically delete the
relevant measurement job.

How to edit the input of the PROFINET communication channel
1. Select the PROFINET communication channel in the expanded overview on the left.

2. Select the required input under Inputs for communication channel: PROFINET in the table.

3. Click on Edit  and make the desired entries in the Edit input window.

4. Click on OK to accept your changes.
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8.7.5 Communication channel for Schaeffler Cloud

You can use the  Communication channel (Schaeffler Cloud)  area to expand the possibilit ies of
monitoring the condition of the SmartCheck or ProLink device by connecting to the Schaeffler Cloud and
transferring data to the cloud using the SmartCheck or ProLink device.

In order to use the cloud functionality, the following steps are necessary:

· You must first connect the Schaeffler Cloud services  (cloud onboarding). The communication channel for
the Schaeffler Cloud is created automatically and all necessary settings are made.

· If necessary, configure the proxy settings of the communication channel (Schaeffer Cloud) by clicking on Edit.

Further information on Schaeffler Cloud can be found in the Schaeffler Mediatheque.

8.8 Device

Under Device, you will find the Device settings  and System time settings . Click on the desired area to
view the main settings of the SmartCheck or ProLink device. Some settings can also be changed here.

8.8.1 Device settings

Under Device Settings, details on the Schaeffler SmartCheck or ProLink device, the network, and the keys and
the status LED on the device are listed:

You can find the following information here:

Device settings
The name, serial number and MAC address (network address) of the SmartCheck or ProLink device
are listed here. If specified, you will also find the description and position of the device here.
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Changes are possible for the entries under Name, Description and Position; to make changes, click on

Edit  and enter the desired changes.

Key/LED settings
The Schaeffler SmartCheck device has two keys and one status LED. The Schaeffler ProLink device also
has two keys and three LEDs.

Under Key/LED settings, you can specify the actions permissible with the keys. In this way, you protect
the SmartCheck or ProLink device against inadvertent operation. You can also specify here whether the
status LED on the SmartCheck device or the alarm LED on the ProLink device is to display alarm statuses.
As a rule, the following settings are possible:

Reset alarm(s) This switches off all existing alarms.

Restart learning mode This restarts the Learning mode ; current measurement values and
alarm limits are retained; only the process for determining new alarm
limits is restarted.

Reboot device This restarts the SmartCheck or ProLink device, i.e. the device is shut
down and booted up again.

Restore factory default
setting

This resets the SmartCheck or ProLink device to the factory default
setting. All the settings and configurations you made are lost.

Enable status LED This option is activated by default.

If you disable the option, it will affect your system in the following way:

· ProLink device: The alarm LED signals are disabled.

· SmartCheck device: The alarm signals of the status LED are disabled.
It still flashes yellow and red for instance when the firmware is
updating.

The SmartCheck or ProLink device then no longer indicates the alarm
status through a red, yellow or green light.

The key lock is enabled by default to prevent unintentional operation. You can find details on which key
or key combination you have to press in each case in the Schaeffler SmartCheck or ProLink user
documentation.

To change the key/LED settings, proceed as follows:

1. Click on Edit 

2. In the Edit key/LED settings window, define the permissible actions:

· If you deactivate a key option, the corresponding key can no longer be used for this purpose. In our
example, this applies to Restore factory default setting.

· If you deactivate the Enable status LED option, the alarm status is no longer indicated on the
SmartCheck or ProLink device.

3. Click on OK to save your changes.

Network settings
The current settings for DHCP, Host name, IP address, Gateway and Netmask are listed here. To
change the network settings, proceed as follows:
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1. Click on Edit 

2. In the Edit network settings window, enter the desired specifications:

You have the following options:

No DHCP With this option, you can specify the IP address or continue to use the
SmartCheck or ProLink device's default IP address.

If No DHCP is enabled, you must also change the other settings in this
step, such as IP address, Netmask, Gateway or DNS server.
The DNS server is required when you create an email communication
channel  using either the SMTP server or the proxy server as a name
and not as an IP address. In this case, the specified server name is
resolved by the DNS server.

DHCP client mode
(load host name from server)

With this option, the SmartCheck or ProLink device automatically
receives an IP address within your network. The host name is specified
via the network's DNS server (reverse DNS).

DHCP client mode
(send host name to server)

With this option, the SmartCheck or ProLink device automatically
receives an IP address within your network. The host name is
registered by the SmartCheck or ProLink device in the network's DNS
server.

3. Click on OK to save your changes.

· If you change the IP address of the SmartCheck or ProLink device, you no longer
have access to the SmartWeb software at the previous address. You must then
enter the new address in the browser in order to load the software again.

· If the IP address is allocated automatically via DHCP, the SmartCheck or ProLink
device can only be accessed via the automatically allocated IP address. You can
no longer use the default IP address.
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8.8.2 System time settings

· Schaeffler SmartCheck or ProLink has an internal clock, which will be operational provided
that the device is supplied with power. However, as it has no buffer battery, it becomes
inoperative as soon as the power supply is interrupted – unless you have connected an
external battery or power supply to the battery input.
If you restore the interrupted power supply and you have selected Set system time
manually, you should correct the system time, otherwise the internal clock will continue
to run from the time of the last successful measurement before the power failure.
For information on how to connect the internal clock to an external battery, refer to the
user documentation Schaeffler SmartCheck or ProLink.

· If a new SmartCheck or ProLink device does not have access to information on the
current time, the time information is taken from the firmware.

Under System time settings, various details on the system time of SmartCheck or ProLink are listed:

The following information and functions can be found here:

System time
Here the current date and current time of the SmartCheck or ProLink device are displayed.

NTP activated
Here you can see whether the SmartCheck or ProLink device loads the system time from an NTP server,
i.e. a time server in the network. If so, Yes will be displayed here.

NTP server
If the SmartCheck or ProLink device loads the system time from an NTP server, you will see the name of
the server here.

Edit button
To change the settings for system time and NTP server, proceed as follows:

1. Click on Edit 

2. In the Edit system time window make the desired specifications:
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Method Here you can specify what the system time of the SmartCheck or ProLink device
should be based on. The time setting can have the time of the connected PC or
that of an NTP server as its reference. You can also enter it manually.

If the system time is based on an NTP server, synchronization runs constantly. For
this method, therefore, the SmartCheck or ProLink device must have a permanent
connection to the network, and the NTP server must always be accessible.

Date Only in the case of Set system time manually: enter the current date and the
current time here. You can either select the date from the list boxes or set it

directly from the calendar .

NTP server Only for Use NTP server to synchronise system time: specify the name of the
NTP server here. using the IP address of the desired NTP server.

Time zone of
device

Here you can select the time zone in which the SmartCheck or ProLink device is
located.

3. Click on OK to save your changes.

8.9 Bearing

Schaeffler SmartCheck or ProLink contains a comprehensive bearing database, to which you can add further
bearings. These bearings are available when you create a new measurement configuration . In the Bearings
area, you will find an overview with search function:
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The following information and functions can be found here:

· Searching for bearings by manufacturer is possible. You can expand the corresponding list box as much as you
like in the Bearing manufacturer  area.

· You can search for bearings by name in the database. To do so, enter the name in the Search criteria field.
Here you have the following options:

§ The placeholder * stands for any character string.

§ The placeholder ? stands for any single character.

§ Upper/Lower case is irrelevant.

· The details on the bearing currently selected are displayed under Bearing information. In the example, you can
see the details for the first bearing in the list. In the yellow box on the right, you will find the details on the
creation and changing of the selected bearing.

· You can add a new bearing

· You can copy and edit existing bearings

· You can delete copies of bearings or newly created bearings. To do this, select the relevant bearing, click on

Delete , and choose OK to confirm.
Bearings that are used in a measurement job cannot be deleted.

· In the top right corner, click on  to open the Configuration overview .

You can neither delete nor edit the bearings from the preset database. However, you can
copy a bearing from the database and then edit the copy.

8.9.1 Adding/editing bearings

You can expand the Schaeffler SmartCheck or ProLink bearing database as much as you like. In doing so, you have
two options:

· You can add new bearings .

· You can copy existing bearings , edit the copy and then save it under a new name.
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How to add a new bearing

1. Under Bearing information, click on Add .

2. In the Add bearing window, make the desired specifications:

You have the following options:

Name Enter the name of the bearing here. You can also find the bearing under this
name if you want to select it for a measurement job.

Manufacturer Select the manufacturer for the new bearing here. What is in this list box is
determined by your selections in the Bearing manufacturer  area.

Normalised kinematic
frequencies

These specifications are important for the correct calculation of bearing
damage frequencies and thus for the reliable monitoring of this component.
You can find the corresponding information on BPFI, BPFO, BSF and FTF in
the technical data of the bearing.

Alternatively, you can have the normalised kinematic frequencies calculated
with the help of the program, using the geometry of the bearing (see below).

Calculate normalised
kinematic frequencies

Click here to calculate normalised kinematic frequencies with the aid of the
bearing geometry. In this case, you need the load angle, the diameter of
the pitch circle and of the roller element, and the number of roller
elements:
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If you want to add a double-row bearing, only enter the number of one row in
Number of roller elements.

Make the corresponding specifications and then click on Calculate. The
software calculates the values for the normalised kinematic frequencies from
the geometry and transfers them to the corresponding fields.

Verify bearing Click here to check your specifications for plausibility. This check reduces the
probability of you having made incorrect specifications for the normalised
kinematic frequencies. Otherwise, the bearing is accepted into the database
without a plausibility check.

3. Click on OK to add the new bearing to the database.

How to copy and edit a bearing
The bearing database, which is already available in the factory default setting of the Schaeffler SmartCheck or
ProLink device, is write-protected; the individual bearings can be neither edited nor deleted. However, you can copy
a bearing from the database and edit the copy, e.g. to create a new bearing with only minor deviations. To do this,
proceed as follows:

1. Select the bearing you want to copy and edit

2. Under Bearing information, click on Copy 

3. In the Copy bearing window, make the desired specifications. If you do not change the name here, Schaeffler
SmartCheck or ProLink creates by default a bearing with the name Copy of [name of the original bearing].

4. Click on OK to save your changes and transfer the bearing into the database.

Calculating normalised kinematic frequencies from the bearing geometry requires expert
knowledge. Only with the correct specifications for angles and diameters can the values for
the bearing be determined correctly and lead to a correct measurement configuration.

8.10 Bearing manufacturer

If you add a new bearing in the Bearing  area, you also have to specify the manufacturer of the bearing. You
manage the manufacturers available for selection in the Bearing manufacturer area:
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Here you have the following options:

· Add manufacturer: Under Manage manufacturers, click on Add , enter the name of the manufacturer
and confirm with OK.

· Edit manufacturer: Under Manage manufacturers, click on Edit , change the name of the manufacturer
and confirm with OK.

· Delete manufacturer: Under Manage manufacturers, click on Delete  and confirm with OK.

· In the top right corner, click on  to open the Configuration overview .

You can neither delete nor edit manufacturers that you have already used in the
specifications for a bearing.

56



160

9 User management

Click on the User management  button to open the corresponding area. Here you can change, add and delete
user groups and users in the SmartWeb software. You can also activate and deactivate the user management here.
On the left, you will find an overview of all user groups and users. The user currently logged in is displayed in the
top right in the tit le bar next to Logged in as.

In the factory default setting, the user groups Administrator, Remote and Guest are created with the users
admin, remote and guest. If you select a group or an individual user, you will see the corresponding details and
rights in the main panel:

Here you have the following options:

User groups
If, as in the example, you select a user group in the expanded overview, you will find the following in the
main panel:

· The name of the selected User group is displayed on the left.

· Below the name, you will find the list of Rights  for the selected user group. The rights activated
here – i.e. the ones that are ticked – are granted to every user you create for this user group. To

change the rights, click on Edit .

· Beside the rights, you will find the list of Members of the user group. This gives you a quick
overview of the users who, for example, were affected by a change to the user group.

· You can add or edit a user group . This excludes the system user groups Administrator and
Remote, which cannot be changed.

· You can delete a user group provided that it is empty, i.e. it no longer contains any users. To do so,

click Delete  and confirm with OK.

· On the right, in the field highlighted in yellow, you will find details on creating and changing the user

group. The  symbol indicates user groups that you can neither change nor delete. This includes the
system user groups Administrator and Remote.
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Users
If you select a user in the expanded overview, you will find the following in the main panel:

· The User ID and the details on the selected user are displayed on the left.

· Beside the details, you will find the list of the Rights  for the selected user. The rights activated
here - i.e. the ones that are ticked - are granted to the user via membership of a user group. The
rights can only be changed for the whole user group.

· You can add or edit a user . This excludes the system users admin and remote, which cannot be
changed.

· You can delete a user. To do so, click Delete  and confirm with OK.

· On the right, in the field highlighted in yellow, you will find details on creating and changing the user.

The  symbol indicates users whom you can neither change nor delete. This includes the system
users admin and remote.

Rights
When you create a user group, you can grant rights that will then apply for every user in this user group.
The following rights are available:

· Edit system settings
This allows the settings found under Device settings  and System time settings  to be edited
by the user.

· Create configurations, Edit configurations and Delete configurations
With these rights, the user can create, edit and/or delete configurations accordingly. Excluded from
this right are the input and output configurations, which have their own rights (see below).

· Configure inputs and Configure outputs
With these rights, the user can configure inputs and outputs and create scaling factors.

· Create users/user groups, Edit users/user groups and Delete users/user groups
If you grant these rights, the user can execute the corresponding functions of the user management.

· Download data
This right is necessary if the user wants to download and analyse data from the  SmartCheck or ProLink
device.

· Reset alarm(s)
This right enables the user, using the SmartWeb software, to switch off the alarms of the SmartCheck
or ProLink device.

· View trend/real-time data etc.
This allows the user to open the Live view  and Measurement data  areas and use the
corresponding functions there.

· Delete measurement data
This right allows the user to delete measurement data  that is on the SmartCheck or ProLink
device.

· View confidential configurations
 This right allows the user to view alarm limits and frequency bands for sensitive measurement jobs .

· Edit confidential configurations
· This right allows the user to view and edit alarm limits and frequency bands for sensitive measurement

jobs .

· Edit speed channel
This right allows users to edit the speed channel, even if they otherwise have only limited
authorisations and/or are not allowed to process measurement jobs.

· Edit hour meter
This right allows users to edit the value of the hour meter.

Activate/Deactivate user management
By default, you can open the SmartWeb software without logging in with your user name and password.
So that the software and the SmartCheck or ProLink device can only be operated by authorised users,
you can Activate user management. With activated user management, each user has to log in with
user name and password. Users only have the rights granted to their user group.

To activate user management, click on the corresponding menu item, enter a new administrator
password twice and then click on OK. You must then refresh the Schaeffler SmartWeb software in your
browser, so that the user management is active.

To deactivate user management again, click on the corresponding menu item, enter the administrator
password and then click on OK. The administrator password is reset to the factory default setting. Now
everyone can log in without user name and password and everyone has administrator rights.
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Change password
This function is only available if user management is activated.

Click on Change password, enter your new password twice and then click on OK. Now you can use the
new password.

· If you are using the Schaeffler SmartUtility software, you can store your user name and
password in the software settings. To do so, your details here must match the user name
and password stored in the user management of the SmartWeb software.

· In the factory default setting, system users have the following passwords:

· User ID admin: Password admin123
· User ID remote: Password remote123
· User ID guest: Password guest123

9.1 Adding/editing user group

To be able to create a user, you first need a user group. A user group consists of a name and a selection of
rights . These rights pass automatically to every user in this group. Thus, the rights users have when using
Schaeffler SmartCheck or ProLink are defined by means of the group they belong to.

How to add a user group
1. In the overview on the left, select User groups.

2. In the main panel, click on Add .

3. In the window  Add user group, make the desired specifications:

You have the following options:

User group Here, enter the name under which the user group is to appear in the
overview.

Right Here, activate the rights that are to apply for users in this user group. You can
either select each right individually or activate them all at the same time via
Right.

4. Click on OK to save the new user group.
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How to edit a user group
1. In the expanded overview, click on the desired user group.

2. Click on Edit  and enter the desired specifications in the Edit user group window.

3. Click on OK to adopt your changes.

9.2 Adding/editing users

You can only add users in connection with a user group. The user group is used to define the rights  that the
user has for Schaeffler SmartCheck or ProLink.

How to add a user
1. In the overview on the left, select User.

2. In the main panel, click on Add .

3. In the Add user window, make the desired specifications:

You have the following options:

User ID Here enter the user ID with which the user will log into SmartCheck or ProLink
in future.

Password Enter here the password that the user will use to log into SmartCheck or
ProLink in future.

User group Specify here the user group that the user is to belong to. Use the user group
to determine the rights that the user will have.

Surname, first name
email, phone

Specify here the contact data of the user. This information is optional.

Comment Enter here any comment you may want to add about this user.

1. Click on OK to save the new user.

How to edit a user
1. In the expanded overview, click on the user.

2. Click on Edit  and enter the desired specifications in the Edit user window.

3. Click on OK to adopt your changes.
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10 Manufacturer/support

Manufacturer
Schaeffler Monitoring Services GmbH

Kaiserstraße 100

52134 Herzogenrath

Germany

Tel.: +49 2407 9149-66

Fax: +49 2407 9149-59

Internet: www.schaeffler.com/en/services

Further information:

· www.schaeffler.de/en/condition-monitoring/smartcheck

· www.schaeffler.de/en/condition-monitoring/prolink

Contact: industrial-services@schaeffler.com

Please send all correspondence directly to Schaeffler Monitoring Services GmbH!

A subsidiary of

Schaeffler Technologies AG & Co. KG

PO Box 1260

97419 Schweinfurt

Germany

Georg-Schäfer-Straße 30

97421 Schweinfurt

Germany

Support
For information on technical support, go to www.schaeffler.de/en/technical-support.

We provide support services for the device and related software products. For a detailed description of the nature
and scope of our support services, go to:

· www.schaeffler.de/en/condition-monitoring/smartcheck

· www.schaeffler.de/en/condition-monitoring/prolink

You can find the support definition in the "Technical documents" > "Software, Licences, Manuals" section.

http://www.schaeffler.com/services
http://www.schaeffler.de/en/condition-monitoring/smartcheck
http://www.schaeffler.de/en/condition-monitoring/prolink
mailto:industrial-services@schaeffler.com
http://www.schaeffler.de/en/technical-support
http://www.schaeffler.de/en/condition-monitoring/smartcheck
http://www.schaeffler.de/en/condition-monitoring/prolink
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